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About This Document
This manual is intended for administrators and users of the 
AXIS 241Q/241S Video Server, and is applicable for 
software release 4.20. It includes instructions for installing, 
using and managing the AXIS 241Q/241S on your network. 
Previous experience of networking will be of use when 
installing and using this product. Some knowledge of UNIX 
or Linux-based systems would also be beneficial, for 
developing shell scripts and applications. Later versions of 
this document will be posted to the Axis Website, as 
required. See also the product’s online help, available via 
the Web-based interface.

Safety Notices Used In This Manual
Caution! - Indicates a potential hazard that can damage the 
product.
Important! - Indicates a hazard that can seriously impair 
operation. 
Do not proceed beyond any of the above notices until you 
have fully understood the implications.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product contains licensed third-party software. See the 
menu item “About” in the product’s user interface for more 
information.

Legal Considerations
Camera surveillance can be prohibited by laws that vary 
from country to country. Check the laws in your local 
region before using this product for surveillance purposes. 
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or 
more of the following measures: Re-orient or relocate the 
receiving antenna. Increase the separation between the 
equipment and receiver. Connect the equipment to an 
outlet on a different circuit to the receiver. Consult your 
dealer or an experienced radio/TV technician for help. 
Shielded (STP) network cables must be used with this unit 
to ensure compliance with EMC standards.

USA - This equipment has been tested and found to 
comply with the limits for a Class B computing device 
pursuant to Subpart B of Part 15 of FCC rules, which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to 
cause interference, in which case the user at his/her own 
expense will be required to take whatever measures may be 
required to correct the interference. 

Europe  -  This digital equipment fulfills the 
AXIS COMMUNICATIONS<Product Name> Quick User’s Guide
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requirements for radiated emission according to limit B of 
EN55022/1998, and the requirements for immunity according 
to EN55024/1998 residential, commercial, and light industry.

Liability
Every care has been taken in the preparation of this manual; 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right 
to make changes to the product and manuals without prior 
notice. Axis Communications AB makes no warranty of any 
kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties 
of merchantability and fitness for a particular purpose. Axis 
Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the 
furnishing, performance or use of this material.

Trademark Acknowledgments
Acrobat, Adobe, Boa, Ethernet, IBM, Internet Explorer, LAN 
Manager, Linux, Macintosh, Microsoft, Mozilla, Netscape 
Navigator, OS/2, UNIX, Windows, WWW are registered 
trademarks of the respective holders. QuickTime™ is a 
trademark of Apple Computer, Inc., registered in the U.S. and 
other countries. Java and all Java-based trademarks and logos 
are trademarks or registered trademarks of Sun Microsystems, 
Inc. in the United States and other countries. Axis 
Communications AB is independent of Sun Microsystems Inc. 
UPnP™ is a certification mark of the UPnP™ Implementers 
Corporation.

Support Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. 

Search by product, category, or phrases
• report problems to Axis support staff by logging in to your 

private support area
• visit the Axis Support Web at www.axis.com/techsup/

Safety Notice - Battery Replacement
The AXIS 241Q/241S uses a 3.0V CR2032 Lithium battery as 
the power supply for its internal real-time clock (RTC). This 
battery will, under normal conditions, last for a minimum of 5 
years. Low battery power affects the operation of the RTC, 
causing it to reset at every power-up. A log message will appear 
when battery replacement is required.

The battery should not be replaced unless required!
If the battery does need replacing, observe the following points:

Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, as 
   recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 
   instructions.

AXIS 241Q/241S User’s Manual 
Revision 2.1
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Part No: 24241
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 6 AXIS 241Q/241S - Product Description
Product Description
The AXIS 241Q/241S is a fully featured video server for security surveillance and remote 
monitoring needs. Based on the AXIS ARTPEC-2 compression chip, it can digitize up to 4 
analog video sources and make these available on the network as real-time, full frame rate 
Motion JPEG and/or MPEG-4 video streams.

The AXIS 241Q has 4 BNC inputs for analog video devices and the AXIS 241S has 1 BNC 
input and a matching loop-through output. The AXIS 241S can also accommodate Y/C 
video using an Y/C to BNC cable (not included). 

The AXIS 241Q/241S is equipped with RS-232 and RS-485 ports for the connection of 
third party PTZ systems. It also has 4 alarm inputs and 4 alarm outputs, which can be used 
to connect various third party devices, e.g. door sensors and alarm bells. 

Up to 20 viewers can access the camera simultaneously when using Motion JPEG and 
MPEG-4 unicast. If MPEG-4 multicast is used, the number of viewers is unlimited, but 
when viewing with the AXIS Media Control (AMC), each viewer still needs a separate 
MPEG-4 decoder license. The AXIS 241Q/241S includes one such decoder license. 
Additional licenses can be purchased separately from your Axis dealer. If using other 
clients to view the video stream, no further MPEG-4 decoder licenses are required.

Video can be viewed in 5 resolutions (up to 4CIF), and image compression is configurable. 
The video server contains support for video motion detection, which allows the unit to 
trigger on activity in the video image, and advanced scheduling tools which can also be 
used to trigger an event. As the AXIS 241Q/241S is designed for use in security systems, it 
is equipped with several security features, such as IP address filtering, several user levels 
with passwords, and HTTPS.

The AXIS 241Q/241S has a built-in web server, providing full access to all features 
through the use of a standard browser. The built-in scripting tool allows basic applications 
to be created, providing basic surveillance solutions. For advanced functionality, the video 
server can be integrated via the use of the AXIS HTTP API (see www.axis.com/developer).

Hardware Inventory
Check the items supplied with your AXIS 241Q/241S against the following list:

Video Server AXIS 241Q or AXIS 241S

Printed user documentation AXIS 241S/241Q User’s Manual This document

Warranty Document Warranty Document

Power adapter PS-K Country-specific

Terminal block connector 12-pin

Mounting kit For wall or rack mounting

Converter cable (optional) ACC Y/C to BNC cable AXIS 241S only. Not included.

MPEG-4 licences (optional) 10-user licence pack Not included

Item Title/variant Notes
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AXIS 241Q Front Panel

Indicators - After completion of the startup and self-test routines, the multi-colored 
Network, Status, Power Indicators flash as follows:

Amber Flashes for activity on a 10 Mbit/s network

Green Flashes for activity on a 100 Mbit/s network

Red Flashes rapid red for hardware error, together with the Status indicator

None No connection

Green Normal operation

Amber Flashes during reset to factory default or at firmware upgrade

Red Flashes rapid red for a hardware error, together with the Network indicator

Green Normal operation

Amber Flashes green/amber during upgrade

DIP Switches - A corresponding line termination switch for each of the supported video 
inputs. All units are shipped with the line termination enabled for each supported video 
input; that is, with the DIP switches set in the down-position.

Note: If the AXIS 241Q is to be connected in parallel with other equipment, disable the input termination by turn-
ing the corresponding DIP switch to the up-position (OFF). Failure to do so may cause reduced image  
quality.

Control Button - Press this button to restore the factory default settings, as described in 
Resetting to the Factory Default Settings, on page 47, or to install using AXIS Internet 
Dynamic DNS Service (page 15).

Video Inputs - Accommodates up to 4 separate video sources (VIDEO 1 - VIDEO 4) 
simultaneously. Each supported video input is connected using a coax/BNC connector. 
Physical connections made using e.g. 75 Ohm coax video cable have a recommended 
maximum length of 800 feet (250 meters).

Network

Status

Power
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 8 AXIS 241Q/241S - Product Description
AXIS 241S Front Panel

Indicators - After completion of the startup and self test routines, the multi-colored 
Network, Status, Power Indicators flash as follows:

Amber Flashes for activity on a 10 Mbit/s network

Green Flashes for activity on a 100 Mbit/s network

Red Flashes rapid red for hardware error, together with the Status indicator

None No connection

Green Normal operation

Amber Flashes during reset to factory default or at firmware upgrade

Red Flashes rapid red for a hardware error, together with the Network indicator

Green Normal operation

Amber Flashes green/amber during upgrade

DIP Switches - upon delivery the AXIS 241S is configured for composite video input.

1 2 3 4

on off on n/a

on on off n/a

Note: If the AXIS 241S is to be connected in loop-through with other equipment, disable the input termination by 
setting switch 1 to the up-position (OFF). Failure to do this may cause reduced image quality.

Control Button - Press this button to restore the factory default settings, as described in 
Resetting to the Factory Default Settings, on page 47, or to install using AXIS Internet 
Dynamic DNS Service, see page 15.

Video Input - Coaxial BNC connector supporting a single composite video source. The 
physical connection is made using 75 Ohm coax video cable with a recommended 
maximum length of 800 feet (250 meters).

Note: The AXIS 241S supports conversion between composite video and Y/C (S-video) using an Y/C to BNC cable. 

Video Output - A single video loopthrough (VIDEO OUT) connected in parallel with VIDEO 
IN and terminated with a coax/BNC connector. Allows direct connection of e.g. an external 
monitor. Set dipswitch to OFF when in use.

Network

Status

Power

Switch

Description
75 ohm video in

termination
75 ohm video out

termination
Connects video in and 

video out
Not used

Composite video input

Y/C video input
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AXIS 241Q/241S Rear Panel

The Serial Number is 
located on the label 
on the underside of 
the unit.

Power Supply Connector - A single socket for connection of the PS-K power adapter. 

I/O Terminal connector - The I/O Terminal connector provides the physical interface to 4 
digital transistor outputs, 4 digital inputs and an RS-485 interface. See Unit Connectors, on 
page 48 for more information.

Note: The I/O Terminal connector also provides an auxiliary connection point for DC 
power.

Network Connector - The AXIS 241Q/241S connects to the network via a standard 
network cable. The AXIS 241Q/241S detects the speed of the local network segment 
(10BaseT/100BaseTX Ethernet).

RS-232 Serial Connector - A 9-pin D-sub connector providing an RS-232 serial 
connection. Typically used for connecting Pan/Tilt/Zoom devices. See Unit Connectors, on 
page 48 for more information.
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Installation 

Mounting

The AXIS 241Q/241S is supplied with a mounting kit for wall or rack mounting. The 
mounting brackets can be positioned for mounting the video server on a vertical surface or 
in a rack (4U). Follow the instructions below to attach the brackets to the video server:

❷

❸

Position and attach the brackets on each 
side, using the screws provided.

Insert the metal plates in the slots on 
each side of the video server.

❶

❶

Slide the grey frame off the front panel 
of the video server (no tools needed).

❸

❸

Alternative A

Alternative B
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Connecting video cameras        Coaxial cable

Connect the video output of your 
camera(s) to the AXIS 241Q/241S video 
server using a standard 75 Ohm coaxial 
video cable with BNC connectors.

Note: Use a RCA-to-BNC adapter if your camera has a standard phono-type (RCA) connector.

Installation Methods

The AXIS 241Q/241S is designed for installation on an Ethernet network. This involves 
assigning it an IP address, either manually or via an automated network service (DHCP). 
Select one of the following procedures depending on your network: 

• In Windows, use AXIS IP Utility to discover a dynamic IP address, or to set the IP address 
manually.

• If your network uses a DHCP server, view its administration pages to discover which IP 
address has been assigned to your AXIS 241Q/241S. 

• If your network uses a DHCP server and your computer is running UPnP™, the AXIS 
241Q/241S will automatically be detected and displayed on your screen. See page 12.

• Assign an IP address manually using the ARP/Ping method, as described on page 13.
• If your network has an Internet connection (with no HTTP proxy) and uses a DHCP server 

to assign IP addresses, use the One-Click installation procedure. See page 15.

Notes: • The AXIS 241Q/241S has a default IP address: 192.168.0.90
• DHCP is enabled by default in the AXIS 241Q/241S
• UPnP™ is enabled by default in the AXIS 241Q/241S

AXIS IP Utility

AXIS IP Utility is a free Windows 
application that discovers and displays 
Axis devices on your network. The 
application can also be used to 
manually set a static IP address. 
Download AXIS IP utility from the 
support pages at: 
www.axis.com/techsup/software

Automatic discovery

1. Check that the network and power cables are connected to the AXIS 241Q/241S.

2. Start AXIS IP Utility. When the AXIS 241Q/241S appears in the window, double-click 
it to open the home page. 
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Set the IP address manually

If the AXIS 241Q/241S does not appear in the window, click the Refresh button to try 
again. If it still does not appear, set the IP address manually. 

1. Acquire an unused IP address. AXIS IP Utility detects the subnet your computer is 
connected to. The AXIS 241Q/241S must be installed on the same network segment.

2. Click the button “Set IP address using serial number” and enter the serial number and 
IP address for the AXIS 241Q/241S. 

3. Click the Set IP button and then restart the AXIS 241Q/241S (within 2 minutes).

4. Click View Home Page to access the AXIS 241Q/241S Web pages.

5. Enter a password for the root user (administrator).

6. If required, accept the installation of AMC onto your workstation.

Notes: • AXIS IP Utility can also be used to change the IP address of a previously discovered Axis device.
• AMC (AXIS Media Control) must be installed to view live video in Microsoft Internet Explorer. If your 

working environment restricts additional software components, you can configure your AXIS 241Q/241S to 
use a Java applet for updating the images. See the help file Live View Config > Layout > Default Viewer for 
Internet Explorer, or use another supported Web browser, see Technical Specifications, on page 57. 

7. The installation is now complete. Proceed to Using the video server, on page 16. 

UPnP™ 

UPnP functionality is enabled by default in the AXIS 241Q/241S. If also enabled on your 
computer (Windows ME or XP), the video server will automatically be detected and a new 
icon will be added to “My Network Places.” Click this icon to access the AXIS 241Q/241S. 

Note: 

To install the UPnP service on your computer, open the Control Panel from the Start Menu and select 
Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Services 
section. Click Details and then select UPnP as the service to add. 

The serial number (S/N) is located on the label on the underside of the AXIS 241Q/241S

UPnPTM is a certification mark of the UPnPTM Implementers Corporation.
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ARP and Ping in Windows
Assign your product a unique IP address from a computer on your network as follows:

1. Acquire an unused IP address for the AXIS 241Q/241S from your network 
administrator.

2. Connect the AXIS 241Q/241S to the network using a standard network cable.

3. Locate the serial number (S/N) found on the label on the underside of the AXIS 
241Q/241S.

4. From a computer on your network, open a Command Prompt, i.e. from the Windows 
Start menu, select Run... and type cmd (command in Windows 98/ME). Click OK.

5. Enter the commands:
           Syntax:

   Example

6. Start/restart the AXIS 241Q/241S. This must be done no later than 2 minutes after 
entering the ARP and Ping commands.

7. When ‘Reply from 192.168.0.125: ...’ is displayed (approximately 10-15 seconds), type 
Ctrl+C to stop Ping.

8. Start a browser and enter the IP address in the Address/Location field.

9. Press Enter.

10. Enter a password for the root user (administrator).

11. If required, accept the installation of AMC onto your workstation.

Note: AMC must be installed to view live video images in Microsoft Internet Explorer. If your working environ-
ment restricts additional software components, you can configure your AXIS 241Q/241S to use a Java 
applet for updating the images. See the help file under Live View Config > Layout > Default Viewer for 
Internet Explorer for information. Or use another supported Web browser, see Technical Specifications, on 
page 57.

12. The installation is now complete. Proceed to Using the video server, on page 16.

arp -s <IP address> <Serial number> 
ping -l 408 -t <IP address>

Note: The ping command is 
followed by -l (lower case L)
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ARP and Ping in UNIX/Linux
Assign your product with a unique IP address from a computer on your network, as 
follows:

1. Acquire an unused IP address for the AXIS 241Q/241S from your network 
administrator.

2. Connect the AXIS 241Q/241S to the network using a standard network cable.

3. Locate the serial number (S/N) found on the label on the underside of the AXIS 
241Q/241S.

4. Start/restart the AXIS 241Q/241S. This must be done no later than 2 minutes after 
entering the ARP and Ping commands.

5. Close the ARP/Ping session when ‘Reply from 192.168.0.125: ...’ (or similar) is 
displayed (approximately 10-15 seconds).

6. Start a browser and enter the IP address in the Address/Location field.

7. Press Enter.

8. Enter a password for the root user (administrator).

9. The installation is now complete. Proceed to Using the video server, on page 16.

Syntax:

arp -s <IP Address> <Serial number> temp 
ping -s 408 <IP address>

Example:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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AXIS Internet Dynamic DNS Service
The AXIS Internet Dynamic DNS Service is a free service provided by Axis. The service 
allows you to quickly and simply install your video server, which then receives a static 
name (DNS name) and a dynamic IP address. More information about the AXIS Internet 
Dynamic DNS Service is available at www.axiscam.net

The video server can be unregistered from the service at any time.

Please visit www.axiscam.net for more details on the AXIS Internet Dynamic DNS Service.

Requirements
Using the AXIS Internet Dynamic DNS Service requires an Internet connection that does 
not require a proxy server for HTTP access. A DHCP server in the network for assigning IP 
addresses is recommended.

Installation Procedure

1. Connect the AXIS 241Q/241S to your local network, using a standard network cable.

2. Connect power to the video server.

3. Wait for the Status indicator on the front of the video server to show a steady green, 
whereupon it will have received a dynamic IP address from a DHCP server on your 
network.

4. Wait 60 seconds and push the control button on the front panel once. The Status 
indicator on the front of the video server will flash green while it connects to the AXIS 
Internet Dynamic DNS service. When the registration process is complete, the indicator 
will return to steady green.

5. Visit www.axiscam.net where you will be guided through the remainder of the 
installation. Please have the serial number of your product ready and follow the 
instructions on the screen.

6. Enter a password for the root user (administrator).

7. If required, accept the installation of AMC onto your workstation.

Note: AMC must be installed to view live images in Microsoft Internet Explorer. If your working environment 
restricts additional software components, you can configure your AXIS 241Q/241S to use a Java applet for 
updating the images. See the help file under Live View Config > Layout > Default Viewer for Internet 
Explorer for information. See also the Technical Specifications, on page 57.

8. The installation is now complete. Proceed to Using the video server, on page 16.

Please note that this procedure will send the AXIS 241Q/241S’s IP address, firmware version, product type 
and serial number to the Axis Internet Dynamic DNS Service. No personal information will be transferred.

The serial number (S/N) is located on the label on the underside of the AXIS 241Q/241S
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Using the video server
The AXIS 241Q/241S can be used with most standard operating systems and supports 
Microsoft Internet Explorer 5.x or later. Other browsers may impose limitations when 
using the AXIS 241Q/241S. For more information please see www.axis.com/techsup

Accessing the video server
1. Start your browser. 

2. Enter the IP address or host 
name of the AXIS 
241Q/241S in the 
Location/Address field of your browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your Web browser. 

Notes: •To view streaming video in Microsoft Internet Explorer, you must set your browser to allow 
ActiveX controls and allow AMC (AXIS Media Control) to be installed on your workstation. AMC 
is required to view MPEG-4. If your workstation restricts the use of additional software compo-
nents, the AXIS 241Q/241S can be configured to use a Java applet for updating JPEG images. 
Please see the online help for more information.

•User functions in the AXIS 241Q/241S may have been customized to meet the specific require-
ments of the application. Consequently, the examples and functions in this section may differ 
from those displayed on your Live View page.
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The Live View page
If the AXIS 241Q/241S has been customized, the buttons and other items described below 
will be displayed accordingly on the Live View page. The following provides an overview 
of each button:

To resize the displayed image, click the View Size buttons: half-size 
(x1/2), full-size (x1), x2 or x4. This will not change the resolution of the 
image (not available in Sequence Mode).

 
The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed. 

The Output buttons control an output directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds. 
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view 
from 2 or more video sources at set intervals.

From the Source list, select the desired video image(s). The list can 
contain internal video sources, external video sources, or the Quad 
Stream view (AXIS 241Q only). The Quad Stream option displays all 
four video images in one stream. 

The Action buttons trigger an event directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in on your 
computer.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet 
Explorer only and displays the following buttons:

The Play/Stop buttons start and stop the live video stream.
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Note that these AMC toolbar functions can also be accessed by right-clicking in the image.

For information on using Pan/Tilt/Zoom controls, please see page 37.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on your keyboard to 
cancel full screen view.
Download from Www.Somanuals.com. All Manuals Search And Download.



 19 AXIS 241Q/241S - Video Streams
Video Streams
The AXIS 241Q/241S provides several different image and video stream formats. The type 
to use depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 241Q/241S provides access to Motion JPEG and MPEG-4 
video streams, as well as to single JPEG images. Other applications and clients can also 
access these video streams/images directly, without going via the Live View page. 

Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to each and every individual image contained in the 
stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high-quality video streams at less than 1 Mbit/s. 

Notes: •MPEG-4 is licensed technology. The AXIS 241Q/241S includes one viewing client license. Install-
ing additional unlicensed copies of the viewing client is prohibited. To purchase additional 
licenses, contact your Axis reseller.

•All clients viewing the MPEG-4 stream must use the same image settings.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 241Q/241S provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS 

Media Control) 

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable 
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.

How to stream MPEG-4?
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first 
consideration for live video, especially when it is important to always have an up-to-date 
video stream, even if some images do get dropped. This can be configured as multicast or 
unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting, so that there is no video 
traffic on the network until a client connects and requests the stream. However, if more 
and more unicast clients connect simultaneously, the server will at some point become 
overloaded. There is also a maximum of 20 simultaneous viewers to be considered.
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RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the 
AXIS 241Q/241S is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in 
Windows. This ActiveX component is automatically installed on first use, after which it 
can be configured by opening the AMC Control Panel applet from the Windows Control 
Panel. Alternatively, right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 241Q/241S can also be accessed in the following ways:

• If supported by the client, the AXIS 241Q/241S can use Motion JPEG server push to dis-
play video. This option maintains an open HTTP connection to the browser and sends 
data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The 
paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/#/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/#/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/#/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/#/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/#/media.amp

Notes: • <ip> = IP address.
• # = video source number or the quad stream. This is set to 1 if omitted.
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Other MPEG-4 clients
Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. 

For some other clients, e.g. QuickTime™ the Video Object Type must be set to Simple. It 
may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip>/mpeg4/#/media.amp 

This path is for all supported methods, and the client will negotiate with the video server to 
determine exactly which transport protocol to use.

Notes: • <ip> = IP address.
• # = video source number or the quad stream. This is set to 1 if omitted.
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Configuring the video server
This section describes how to configure the AXIS 241Q/241S and is intended for:

• administrators, who have unrestricted access to all the Setup tools
• operators, who have access to the Video & Image, Live View Config and Event Config-

uration settings.
The AXIS 241Q/241S is configured from the Setup link, in a standard browser (see 
Technical Specifications, on page 57).

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a browser.

1. Start the browser and enter the IP address or host name of the AXIS 241Q/241S in 
the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Setup tools
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Video & Image Settings
The following descriptions show examples of the available features in the AXIS 
241Q/241S. For details of each setting, please refer to the online help available from each 
page. Click to access the online help.

Image Settings

Image Appearance

Modify the Image Appearance to optimize the video images according to your 
requirements.

All configuration of images and overlays will affect the performance of the video server, 
depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
• Rotating the image 90 or 270 degrees will lower the maximum frame rate
See also the specifications for frame rates and bandwidth on page 60. 
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Overlay Settings

Use these settings to include a) an 
image as an overlay, and/or b) the 
date and time, along with text of 
your own. 

Text overlays are all included on one 
line at the top or bottom of the video 
image. Image overlays can be placed 
anywhere in the video image. 

To upload an overlay image, see 
below.

Example: If there is information in a monitored area that you do not wish to disclose, you can mask it out by 
placing an overlay image on top. Setting the overlay image anywhere in the video image using coordi-
nates allows precision detail masking.

Video Stream

The Maximum video stream time can be set as Unlimited, or a maximum stream time per 
session in seconds, minutes or hours can be defined. When the set time has expired, a new 
stream can be started by refreshing the page in the Web browser. Note that the maximum 
video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Video Source Settings
Enter a descriptive name for the Video source. 

Black borders surrounding the image can be eliminated by adjusting the offset position. 
See the online help for more information.

AXIS 241S only: 

Select the physical connector the video source is connected to, BNC or Y/C. The AXIS 241S 
supports conversion between composite video and Y/C (s-video) using an ACC Y/C to BNC 
cable.

• BNC (composite video) connects a standard video camera or other video equipment 
• Y/C (S-video) connects a Y/C (S-video) camera or other video equipment 

Overlay text

Overlay image
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Pan Tilt Zoom
The settings here are for configuring preset positions and the PTZ Control Queue. For 
detailed information on these settings, please see the online help. For an overview of Pan 
Tilt Zoom functionality, please see page 37. 

Advanced - MPEG-4 Settings
Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help.

Quad Stream Settings (AXIS 241Q only)
The settings are the same as the individual image settings and are active only when the 
quad stream view is selected, see Image Settings, on page 24.
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Overlay Image Settings
An overlay image is an image superimposed over the video image. 

Follow these instructions to upload and use an overlay image:

1. To upload the file (the image) to the AXIS 241Q/241S, click the Browse button 
and locate it on your computer or server. 

2. Click the Upload button and follow the on-screen instructions.

3. The image is now available in the Use overlay image drop-down list.

4. Click Save.

Overlay image requirements:

Overlay image limitations:
• The maximum overlay image size supported by the AXIS 241Q/241S is the same as the 

maximum image resolution. See Technical Specifications, on page 57.
• When a text overlay is also used, this reduces the amount of space available to the 

overlay image. To keep the text readable at lower resolutions, the text overlay occupies 
proportionally more and more space, i.e., 16 pixels in height at 640x480, 32 pixels at 
320x240 and 64 pixels at 160x120. 

• If the overlay is initially positioned so that part of it is outside the video image, it will 
be relocated so that it appears over the video image, i.e. it is always the entire image 
that is displayed.

Please see the online help for more information.

Image Formats Image Size

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

• OS/2 4-bit BMP (16 colors)

The height and width of the overlay image in 
pixels must be exactly divisible by 4.
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Live View Config

Layout
These are the tools for deciding the layout 
of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify the 
default page with your own colors, 
images etc. Click the Configure button 
and see the following page.

• Own Home Page - Upload and use your 
own custom made page as the default 
web page. Click the Configure button 
and see the following page.

The other settings on this page concern 
which other features to include, e.g. 
buttons and links. See page 29 for more 
information.

Customizing the 
default page

The appearance of the 
default AXIS 
241Q/241S Live View 
page can be customized 
to suit your own 
requirements, or you 
can upload and use 
your own home page. 
To upload your own 
files, click the 
Upload/Remove button 
and see the description 
below.

Note that the setup address is http://<ip address>/operator/basic.shtml
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Upload Own Web Files

Your own web files, background picture, color etc. must first be uploaded to the AXIS 
241Q/241S in order to be available for selection in the Custom Settings setup dialog. Once 
uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2. Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3. When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

• To use your uploaded file, click the radio button and select the file from the drop-down 
list by Own:

• To use an external file located somewhere other than in the AXIS 241Q, click the radio 
button and enter the URL by External:

Own Home Page

To use a previously uploaded web page as the default page, check the checkbox, select the 
page from the drop-down list and click OK.

User Defined Links 

Enter a descriptive name and enter the URL in 
the provided field. The link will appear on the 
Live View page.

User defined CGI links can be used to issue 
HTTP API requests, e.g. PTZ commands. 
Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM1 Start 
PTZ.

3. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?
camera=1&continuouspantiltmove=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM1 Stop PTZ.

User Defined Links
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6. Enter the cgi link: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1&continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the PTZ camera

For more information on the Axis HTTP API, see the Support / Developer pages on the 
Axis Web site at http://www.axis.com. See also the section on PTZ, on page 37.

Action Buttons

These buttons can be used to manually trigger and stop an event from the Live View page. 
See Event Servers, on page 32. The snapshot button allows you to take a snapshot of the 
video stream and save it to a computer.

Output Buttons

These buttons are used to control the outputs on the AXIS 241Q/241S and thus the 
equipment connected to them, e.g. to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format in Internet Explorer for Windows

Select the default format to use on the Live View page. Checking the box for Show video 
format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

AMC (AXIS Media Control) Settings

Checking the Show viewer toolbar box displays the AMC toolbar under the video stream. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Default Viewer for Motion JPEG

Select the appropriate radio button to define the method for viewing moving video images, 
depending on your browser and settings.

Please see the online help for more information.
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HTML Examples
You can add live video from your AXIS 241Q/241S to your own web site. The video server 
can send Motion-JPEG or MPEG-4 images to up to 20 simultaneous connections, although 
an administrator can restrict this to fewer. This does not affect or include the number of 
multicast viewers.

Enter the Image Type, Image size and other settings to suit your web page and click 
Update.

External Video
You can add links to other Axis network devices available over the network. These sources 
can be displayed on the Live View page, just as if they were video sources connected 
directly to the AXIS 241Q/241S.

Click the Add button to open the External Video Source Setup dialog, which is used to 
make all the necessary settings.

Example of a path to an external video source:

Sequence Mode
The live view page can be configured to rotate through 
selected internal and/or external video sources, in order or 
randomly. PTZ preset positions can also be included.

Select the desired video sources and enter the time in seconds to display each source (up to 
59 minutes). Click Save.

The Sequence buttons will appear on the Live View page to allow the viewer to start and 
stop the sequence mode.

Please see the online help for more information.

http://192.168.0.125/axis-cgi/mjpeg/video.cgi
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Event Configuration
This section describes how to configure the AXIS 241Q/241S for alarm handling. Various 
actions can be configured to run when certain types of events occur.

A set of parameters describing how and when the video server is to perform certain actions

- the circumstances that start an event e.g. at a signal from an external device, such as a door 
switch or a motion sensor

- the circumstances that start an event e.g. at a pre-programmed time

- what occurs when the event runs e.g. video images uploaded to an FTP server, email notifi-
cation sent, etc.

Event Servers
Event Servers are used for e.g. receiving uploaded image files and/or notification 
messages. To set up Event server for your AXIS 241Q/241S, go to Setup > Event 
Configuration > Event Servers and enter the required information according to the 
selected server type.

For details on each setting, please refer to the online help available from each web 
page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test takes approximately 10 seconds). 

Event type

Triggered Event (see page 
33)

Scheduled Event (see page 
34)

Action

Server type Purpose Information required

FTP Server • receives uploaded images • Descriptive name of your choice
• User Name and Password (to FTP server)
• Upload path, e.g. images/
• Port number
• Use passive mode if there is a firewall between the video server 

and FTP server

HTTP Server • receives notification messages
• receives uploaded images

• Descriptive name of your choice
• URL (address)
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

TCP Server • receives notification messages • Descriptive name of your choice
• User Name and Password (for TCP server)
• Port number
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Event Types
An Event Type is a set of 
parameters describing how 
and when the video server 
is to perform certain 
actions.

Example: If somebody walks past 
the connected camera, and an event 
has been configured to act on this, 
the video server can e.g. record and 
send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-con-
figured message. Video images can be sent as an attachment with the email.

Triggered Event

A triggered event is activated by e.g:

• a push button connected to an input port on the video server
• detected movement in a configured motion detection window
• a lost signal from a video source
• a manually activated action e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event

This example describes how to set the video server to upload images when the main door is 
opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Select which Video Source the event is to act on, e.g. Video 1 on Main door.

5. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

6. Select the trigger alternative from the Triggered by... drop-down list, 
e.g. an Input port with a connected sensor if the door is opened.

7. Set the When Triggered... parameters, i.e. set what the video server should do if 
the main door is opened, e.g. upload images to an FTP server.

8. Click OK to save the event in the Event Types list.

Please see the online help for descriptions of each available option.
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Pre-trigger and Post-trigger buffers

This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 2 minutes before and after a door was opened. Check the Upload 
images checkbox under Event Types > Add Triggered... > Triggered by... to expand the 
web page with the available options.

Buffer size - AXIS 241Q - up to 36 MB buffer; AXIS 241S - up to 9 MB buffer.  
The maximum length of time of the pre-/post-buffer depends on the selected image size 
and frame rate.

Include pre-trigger buffer - images stored internally in the server from the time 
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the 
desired length of time and specify the required image frequency. 

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger. 

Note: If the pre- or post-buffer is too large for the AXIS 241Q's internal memory, the frame rate will be reduced 
and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum available) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.

Scheduled Event

A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event

This example describes how to set the video server to send an email notification with saved 
images from a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. Scheduled email.

3. Set the priority (High, Normal or Low).

4. Select the video source i.e. the source the event should act on, 
e.g. Video 2 in Storage room.

5. Set the Activation Time parameters (24h clock) when the event should be active, 
e.g. start on Sundays at 13.00 with a duration of 12 hours.

6. Set the When Activated... parameters i.e. set what the video server should do at 
the specified time e.g. send uploaded images to an email address.
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7. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each available option.

Motion Detection
In the Motion Detection menu, you can configure the video source(s) for motion detection. 
The motion detection feature is used to generate an alarm whenever movement occurs (or 
stops) in the image. The AXIS 241Q can use a maximum of 40 Include/Exclude windows, 
whilst the AXIS 241S can use a maximum of 10.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion 
detection is selected to trigger an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the video server.

How to configure Motion Detection

This example describes how to configure Video 1 for motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Select video source 1 from the menu (AXIS 241Q only).

3. Click the Configure Included Windows radio button.

4. Click New.

5. Enter a descriptive name of your choice under Windows name.
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6. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

7. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

8. Click Save.

Please use the online help for descriptions of each available option.

High Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects against ordinary 
backgrounds will trigger the motion 
detection

Low Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects against a dark 
background will trigger motion detection

Default values Low Medium to High Medium to High

Examples: 
• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status
Under Event Configuration > Port Status, there is a list that shows the status for the 
connected inputs and outputs of the AXIS 241Q/241S. This is for the benefit of an 
operator, who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Open circuit, as long as the button is 
not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and repeat steps 1-8 above.

Parameter  Size History Sensitivity
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Pan Tilt Zoom 
If the AXIS 241Q/241S has been appropriately configured, the Live View page will display 
the controls available for the installed Pan Tilt Zoom (PTZ) device. The administrator can 
enable/disable the controls for specified users.

Video sources

Preset positions

Tilt bar (relative)

The exact controls shown depends on the make and model of PTZ device. There may be 
e.g. Focus and Iris bars available as well, but the most common controls are;

• the Pan bar - moves the camera to the right and left 
• the Tilt bar - tips the camera up and down
• the Zoom bar - zooms the view in and out. Note that this is only available if the 

camera is fitted with a zoom lens.

Clicking on the bars themselves or on the arrows at the end of the bars will move the 
camera to a new postion. The type of movement and the location of this new position 
depends on the type of PTZ driver. 

When controlling the camera using a relative PTZ driver (see the bars in the illustration 
above) the new position will be relative to the previous position, e.g. left of, below, above, 
etc. Clicking the bar further from the center results in a larger movement. 
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In contrast, when using an absolute driver, each 
position on the bar (see right) represents a defined 
position in the device’s range of movement, with the center of the bar representing the 
point midway between the two extremes of movement.

Clicking a position directly on the bar moves the camera directly to the new position in 
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, 
incremental change. 

Click-in-image

The PTZ device can also be controlled using click-in-image movement, which can also be 
of relative or absolute type.

Absolute click-in-image movement means that the camera view will center on the absolute 
position that was clicked.

Relative click-in-image movement can be used when using the AXIS Media Control with 
Microsoft Internet Explorer, and when using a PTZ driver that supports it. By clicking and 
holding the mouse button down in the image, the PTZ device moves the camera in that 
direction, relative to the center of the image. The further from the center the image is 
clicked, the greater the movement.

Preset Positions

Also available with many PTZ devices are Preset positions. These presets are selected from 
the drop-down Source list on the Live View page and will move and/or zoom the camera 
to a pre-defined position, i.e. to cover an area of particular interest. Events can also be 
configured to go to preset positions when triggered. For information on setting up preset 
positions, please see the online help.

PTZ Control Queue 

This indicates that PTZ queueing has been enabled. This means that the time the user is in 
control of the PTZ device is limited and that a user queue has been set up. Use the buttons 
to request or release control of the PTZ controls. For information on how to set up the 
control queue, please see the online help.

Using CGI links to control PTZ devices

User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. 
PTZ commands. These links are configured in the Live View Layout settings, see page 29.
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Installing PTZ Devices
The AXIS 241Q/241S supports several PTZ devices. Please see www.axis.com for a 
complete list of supported devices, and to obtain the correct driver. Follow the instructions 
below to install a PTZ device:

1. Using an appropriate cable, connect the device to your selected port (RS-232 or 
RS-485). These ports are available via the D-Sub connector and the I/O terminal 
connector, respectively. See pages 48 and 49 for more information.

2. In the setup tools, go to Setup > System Options > Ports & Devices and then 
select the port (RS-232 or RS-485) to configure. 

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. Click Upload to install a PTZ driver. 
(PTZ drivers are available from the Axis Web site at www.axis.com)

5. Click Port Options... to modify the port settings. The default values correspond to 
the values specified by the PTZ driver.

6. From System Options > Ports & Devices, select the port configured for PTZ and 
then select the video source to use with the device.

7. If required, click the Advanced Options button to make further settings.

Note: Advanced users and application developers can also use the Axis Application Programming Interface and 
HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to 
the Axis Website at www.axis.com for further information.
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System Options

Security
User access control is enabled by default, when the administrator sets the root password on 
first access. New users are authorized with user names and passwords, or the administrator 
can choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

Provides the lowest level of access, which only allows the user access to the Live View page
An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.
An administrator has unrestricted access to the Setup Tools and can determine the registration of 
all other users. 

User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View page.
• Anonymous PTZ control login - allows any viewer access to the Pan Tilt Zoom con-

trollers on the Live View page (if Pan/Tilt/Zoom is available).

IP Address Filtering

Allowed IP Addresses - The administrator can add up to 256 IP addresses to this list. If the 
IP address filtering checkbox is checked, the AXIS 241Q/241S will only allow access to 
requests coming from the IP addresses in the list.

The users from these IP addresses need to be specified in the user list with the appropriate 
access rights (User, Operator or Administrator).

Referrals - to prevent unauthorized sources from including the video stream from the 
AXIS 241Q/241S into external Web pages, check the Referrals box and enter the IP 
address or Host name of the computer that hosts the Web pages with the included video 
stream. Multiple IP addresses/host names can be defined and are separated by 
semicolons(;)

Notes: •If the referrals feature is enabled and you wish to also allow normal access to the Live View 
page, the product's own IP address or host name must be added to the list of allowed referrers.

•Restricting referrers has no effect on an MPEG-4 video stream. To  restrict an MPEG-4 stream, 
IP address filtering must be enabled.

•Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP 
addresses.

Viewer

Operator

Administrator
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HTTPS

For greater security, the AXIS 241Q/241S can be configured to use HTTPS (Hypertext 
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would 
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 241Q/241S, a Certificate 
must be created using one of these methods:

• A self-signed certificate can be created in the video server, but this does not guarantee 
the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages 
security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy 
and send to a CA for signing. When the signed certificate is returned, click Install 
signed certificate... to install the certificate in the AXIS 241Q/241S.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please see the online help

Date & Time
Current Server Time - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in overlay images.

New Server Time - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your computer. 
• Synchronize with NTP Server - the video server will obtain the time from an NTP 

server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.
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Date & Time Format Used in Images - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File 
Naming & Date/Time Formats in the online help for information on how to create 
your own file formats.

Network - Basic TCP/IP Settings

IP Address Configuration

The IP address of the video server can be set automatically via DHCP, or a fixed IP address 
can be set manually. DHCP is enabled by default. To use a fixed IP address, you must also 
enter the correct subnet mask and default router.

Notes: •DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via 
DHCP may lead to the situation where the IP address changes and you lose contact. Configure 
the options for notification of IP address change (under Services) to receive notification from 
the video server when the IP address changes.

•Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 241Q/241S 
by host name which is always the same, regardless of the IP address.

Services

Options for notification of IP address change - if the IP address for the video server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - If the AXIS 241Q/241S Video Server has been 
registered with the Axis Internet Dynamic DNS service and the IP address for the product 
changes, the service is updated to reflect the change. Check the box to enable/disable 
automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your 
product can at any time be removed. To do this click Settings... and follow the 
instructions. 

For more information, please refer to the online help
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Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on your 
network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
241Q/241S. Multiple domains can be separated by semicolons (;). The host name is always 
the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully 
Qualified Domain Name myserver.mycompany.com where mycompany.com is the 
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

Host Name Configuration

The AXIS 241Q/241S can be accessed using a host name, instead of an IP address. The host 
name is usually the same as the assigned DNS Name.

For more information, please see the online help

Link-Local Address

This is enabled by default and assigns the AXIS 241Q/241S an additional IP address for use 
with UPnP™. The AXIS 241Q/241S can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other. 

HTTP 

The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554.
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Network Traffic 

The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
video server is allowed to use on your network. This is a useful function when connecting 
your video server to busy or heavily loaded networks. The default setting is Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help

SOCKS 
SOCKS is a networking proxy protocol. The AXIS 241Q/241S can be configured to use a 
SOCKS server to reach networks on the other side of a firewall/proxy server. This 
functionality is useful if the video server is located on a local network behind a firewall, 
but notifications, uploads, alarms, etc., need to be sent to a destination outside the local 
network (e.g. to the Internet).

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the 
fields provided, to enable event and error email messages from the video server to 
predefined addresses, via SMTP. 

If the mail server requires SMTP authentication, check the box for Use authentication to 
log in to this server and enter the user name and password used for logging in. Several 
different methods of authentication are available. See the online help for more 
information. 

UPnP™
The video server includes support for UPnP™ in Windows ME and Windows XP. UPnP™ is 
enabled by default.

Note: UPnP™ must be installed on your workstation. To do this, open the Control Panel from the Start Menu and 
select Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Ser-
vices section. Click Details and then select UPnP™ as the service to add.

RTP (Multicast)/MPEG-4
These settings are the IP address, port number, and Time-To-Live value to use for the video 
stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers should 
be used for multicast streams. For more information, please see the online help.
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Ports & Devices
I/O Ports - the pinout, interface support and the control and monitoring functions 
provided by this connector are described in Unit Connectors, on page 48.

Maintenance
• Restart - The unit is restarted without changing any of the settings. Use this method if 

the unit is not behaving as expected.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that will not be reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the video server's settings to the factory default values (including the IP address)

Upgrade Server - See Upgrading the Firmware, on page 52.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it is then possible to return to a previous configuration if settings are 
changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for multi-configurations or for firmware upgrades.
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Support
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server 
Report with your query.

View Information - The Log report and the Parameter List also provide valuable 
information for troubleshooting and when contacting Axis’ support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis video 
server configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.
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Resetting to the Factory Default Settings
To reset the AXIS 241Q/241S to the original default settings, go to the System Options > 
Maintenance web page (described in Maintenance, on page 45) or use the control button 
on the AXIS 241Q/241S, as described below:

Using the Control Button

Follow the instructions below to reset the AXIS 241Q/241S to the factory default settings 
using the Control Button.

1. Switch off the AXIS 
241Q/241S by disconnecting 
power.

2. Press and hold the Control 
button while reconnecting the 
power.

3. Keep the Control button 
pressed until the Status 
Indicator displays yellow (this 
may take up to 15 seconds).

4. Release the Control button.

5. When the Status Indicator changes to Green (may take up to 1 minute), the 
process is complete and the AXIS 241Q/241S has been reset.

6. Re-install the AXIS 241Q/241S, as described elsewhere in this manual.

Control ButtonStatus Indicator
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Unit Connectors
The following connectors are described in this section:

•  The D-Sub Connector, on page 48
•  The I/O Terminal Connector, on page 49
•  COM Ports RS-232 and RS-485, on page 50
•  Y/C to BNC Cable (AXIS 241S only), on page 51

The D-Sub Connector
The AXIS 241Q/241S provides one 9-pin D-sub connector, providing the physical interface 
for an RS-232 port, used for connecting accessory equipment; such as stand-alone PTZ 
devices for the remote control of connected video cameras. 

Pin assignment table and pinout of the RS-232 connector:

Pin Function
1 CD 
2 - RXD
3 - TXD
4 DTR
5 GND
6 DSR
7 RTS
8 CTS
9 RI

54321

6 7 8 9
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The I/O Terminal Connector
This section describes the pinout and interface support provided by the 12-pin I/O terminal 
connector, which includes: 

• 4 digital transistor outputs
• 4 digital inputs
• an RS-485 interface
• auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering, 
time lapse recording, alarm notification via email, image storage to FTP locations, etc.

• Inputs - e.g. a push button. If the button is pressed, the state changes, and the 
input will be active (shown under Event Configuration > Port Status). 

• Outputs - e.g. an alarm device that can be activated from Output buttons on the 
Live View page or as an action to an Event Type. The output will show as active 
(in Event Configuration > Port Status), if the device is activated.

The AXIS 241Q/241S includes one (green) 12-pin connector block. Connect input/output 
devices to this block:

1. Loosen the corresponding screw on top of the pin on the connector block (see the 
table above to determine which pin to use).

2. Push the cable into the connector block and secure it by fastening the screw.

3. Once all devices are connected, connect the connector block to the video server’s 
terminal connector.

Pin Function Description
1 Auxiliary DC Power Input 7-20 VDC/min 7W. Electrically connected in parallel with PS-k power 

connector, provides an auxiliary connector for mains power to the unit. 
If the product is powered via this pin, use a fuse (Fuse rating: 1A Slow).  
This pin can also be used to power auxiliary equipment, max 100mA 

2 GND

3 Digital Input 1 Connect to GND to activate or leave floating (or unconnected) to 
deactivate.4 Digital Input 2

5 Digital Input 3

6 Digital Input 4 

7 Transistor Output With a maximum load of 100mA and maximum voltage of 24V DC, this 
output has an open-collector NPN transistor with the emitter 
connected to pin 2 (GND). If it is to be used with an external relay, a 
diode must be connected in parallel with the load for protection 
against any voltage transients.

8 Transistor Output

9 Transistor Output

10 Transistor Output

11 RS-485 - A (non-inverting) A half-duplex RS-485 interface for controlling auxiliary equipment, 
e g. PTZ devices.12 RS-485 - B (inverting)
Download from Www.Somanuals.com. All Manuals Search And Download.



 50 AXIS 241Q/241S - Unit Connectors
Schematic Diagram - I/O Terminal Connector
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COM Ports RS-232 and RS-485
The COM Ports RS-232 and RS-485 support several operational modes:

• Generic TCP/IP - enables the video server to receive status/data and send com-
mands via TCP/IP

• Generic HTTP - enables the video server to receive status/data and send com-
mands via HTTP

• Pan Tilt Zoom (PTZ) - for controlling a PTZ device. A PTZ device requires a 
driver for its function. Drivers can be obtained from www.axis.com. Please see 
page 37 for information on how to connect PTZ devices.
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Y/C to BNC Cable (AXIS 241S only)
The AXIS 241S supports conversion from Y/C (S-video) to composite video using an Y/C to 
BNC cable. The cable is available as an accessory - see the Axis Web site at: 
http://www.axis.com. Follow these instructions to connect the Y/C to BNC cable:

1. Connect the BNC connector marked IN to the Video In connector on the video 
server.

2. Connect the BNC connector marked OUT to the Video OUT connector on the 
video server.

3. Connect the Y/C connector to the Y/C video unit (S-video).

4. Set the dip switches on the front panel of the unit to 1=on, 2=on, 3=off, 4=off.

5. Go to the AXIS 241S Web pages under Setup > Video & Image > Video Source 
and select Y/C (S-video) from the Physical connector drop-down list.

One female MiniDin 4-pol connector 

split into two BNC connectors

Below is a description of how the cable is assembled for those who wish to use standard 
components:

1. Use two male BNC connectors and one female 4-pole 
MiniDin connector.

2. Connect pin 1, 2 and shield on the MiniDin connector to 
the shield on the two BNC connectors.

3. Connect pin 3 (Y) on the MiniDin connector to centre pin 
on one of the male BNC connectors, mark this BNC 
connector with IN.

4. Connect pin 4 (C) on the MiniDin connector to centre pin 
on the other male BNC connector, mark this BNC connector 
with OUT.

The pins on the 
MiniDin connector
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Troubleshooting

Checking the Firmware
Firmware is software that determines the functionality of the AXIS 241Q/241S. One of 
your first actions when troubleshooting a problem should be to check the currently 
installed version. The latest version may contain a correction that fixes your particular 
problem. The current firmware version in your AXIS 241Q/241S can be seen under Setup 
> Basic Configuration.

Upgrading the Firmware
When you download firmware from the Axis Web site, your Axis product will receive the 
latest available functionality. Always read the upgrade instructions and release notes 
available with each new release, before updating the firmware.

New firmware can be downloaded to the AXIS 241Q/241S over the network.

Note: Pre-configured and customized settings will be retained for use when the new firmware is running (pro-
vided the features are available in the new firmware) although this is not guaranteed by Axis Communica-
tions. 

1. Save the firmware file to your computer. The latest version of the AXIS 
241Q/241S firmware is available free of charge from the Axis Web site at 
www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the video server’s Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: •Always read the upgrade instructions available with each new release, before updating the 
firmware.

•After starting the process, you should always wait at least 20 minutes before restarting the AXIS 
241Q/241S, even if you suspect the procedure has failed.

•Your dealer reserves the right to charge for any repair attributable to faulty updating by the 
user.
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Emergency Recovery Procedure
If power or the network connection to the AXIS 241Q/241S is lost during the upgrade, the 
process will fail and the unit will become unresponsive. A flashing red Status LED indicates 
a failed upgrade. To recover the unit, follow the steps below. The serial number is found on 
the underside label on the product casing.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of AXIS 241Q/241S> <Serial number> temp 
ping -s 408 <IP address of AXIS 241Q/241S> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of AXIS 241Q/241S> <Serial number> 
ping -l 408 -t <IP address of AXIS 241Q/241S> 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 241Q/241S’s IP address. In the page that appears, 
use the Browse button to select the upgrade file to use, e.g. axis241q.bin or 
axis241s.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power and Status LED:s and flashing green or amber on the 
Network LED. 

5. Reinstall the AXIS 241Q/241S. 

If the emergency recovery procedure does not get the AXIS 241Q/241S up and running 
again, please contact Axis support at www.axis.com/techsup/ 

Support
If you contact Axis support, please help us help you resolve your problems expediently by 
providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial ActionsI  
Problems setting the IP address

Using ARP/Ping - the IP address 
must be set within two minutes 
after power has been applied to 
the video server

Restart the server and try again. Ensure also the ping length is set to 408. See or  ARP and Ping 
in Windows on page 13, or  ARP and Ping in UNIX/Linux on page 14.

The video server is located on a 
different subnet.

If the IP address intended for the AXIS 241Q/241S and the IP address of your computer are 
located on different subnets, you will not be able to set the IP address. Contact your network 
administrator for an IP address on the same subnet as the computer you are performing the 
installation from.

The IP address is being used by 
another device

Disconnect power from the AXIS 241Q/241S.  
Run the Ping command (in a Command/DOS window, type ping <IP address of unit> 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
video server. In this case, check all cabling and reinstall the unit.

The AXIS 241Q/241S cannot be accessed from a Web browser
Cannot log in. If the AXIS 241Q/241S has been configured to use HTTPS, check that the protocol in the URL 

used to access the unit is correct. You may need to type this in manually (i.e. http or https) in 
the browser’s address field.

The IP address has been changed 
by DHCP

1) Move the AXIS 241Q/241S to an isolated network or to one with no DHCP or BOOTP server. 
Set the IP address again, using the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The video server can be configured to use a SOCKS server to reach networks on the other side 

of a firewall/proxy server

Your AXIS 241Q/241S is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily 
loaded

Use a script on your web server to relay images from the AXIS 241Q/241S to the Internet. 

The Power indicator is not constantly lit
Faulty power supply Verify that you are using an AXIS PS-K power supply.

The Status and network indicators are flashing red
Hardware failure Contact your Axis dealer.

The Status indicator is flashing red and the server is inaccessible
A firmware upgrade has been 
interrupted or the firmware has 
been damaged in some other 
way.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping, see page 10. Then, using a browser, access the unit and download the latest firmware 
to the product, see Upgrading the Firmware, on page 52.
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No images displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure your AXIS 241Q/241S to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for more 
information.

Video Image Problems
Image too dark or too light. Check that the termination dip switch for the video source is set to the correct position. See 

also the online help on Video Source Settings

Black borders around the video 
image

Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring e.g. pre-buffers, motion detection, high resolution images, high frame rates, etc., 
will reduce the performance of the video server. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, multiple users accessing the 
unit, low performance clients, use of features such as Motion Detection, Event handling, Image 
rotation.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Incorrect exposure in images
Incorrect line termination If the AXIS 241Q/241S is to be connected in loop through with other equipment, disable the 

input termination by turning the corresponding DIP switch to OFF.

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
AXIS 241Q/241S are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your router supports multicasting, or if the router settings between the client and the 
server need to be configured. The TTL (Time To Live) value may need to be increased.
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For additional assistance, please contact your reseller or check the product’s support pages 
on the Axis Website at www.axis.com/techsup

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

If text overlays are blurred, or if there are other rendering problems, you may need to enable 
Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usuallly 
be downloaded from the manufacturer's web site. 

Color saturation is different in 
MPEG-4 and Motion JPEG.

Modify the settings for your graphics adapter. Please see the adapter's documentation for more 
information.
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Technical Specifications

Item Specification

Models • AXIS 241Q: 4-channel video server
• AXIS 241S: 1-channel video server

Video compression • Motion-JPEG, including single snapshot JPEG images. 
• MPEG-4 Part2 (ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 4CIF, 2CIF Expanded, 2CIF, CIF, QCIF
• Maximum 768x576 (PAL) 704x480 (NTSC)
• Minimum 176x144 (PAL) 160x120 (NTSC)

Frame rates • Motion JPEG: up to 25/30 fps in 4CIF (1 channel), 
up to 25/30 fps in CIF (4 channels)

• MPEG-4: up to 25/30 fps in 2CIF (1 channel), 
up to 17/20 fps in CIF (4 channels)

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and total bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Compression levels: 11 (Motion JPEG), 23 (MPEG-4)
• Rotation: 90o, 180o, 270o

• Aspect ratio correction
• Color and black/white
• Overlays: time, date, text, image

Security • Multiple user levels with password protection
• IP address filtering
• HTTPS encryption

Users • 20 simultaneous viewers
• Unlimited users using MPEG-4 multicast

Alarm and event 
management

• Events triggered by built-in multi-window motion detection, external inputs or 
according to set schedule

• Image uploads via FTP, email and HTTP
• Event notification via TCP, email, HTTP and external outputs
• Pre- and post-alarm buffer of 9 MB per channel (approx 4 min CIF video at 4 fps)

Pan/Tilt/Zoom • Drivers for all supported PTZ units available from www.axis.com
• PTZ control queuing capability

Connectors • Analog composite video, PAL/NTSC autosensing inputs
• AXIS 241Q: 4 BNC video inputs
• AXIS 241S: 1 BNC video input, 1 BNC output (loop through) or Y/C video input
• Ethernet 10BaseT/100BaseTX, RJ-45
• Terminal block: 4 alarm inputs, 4 output transistors (max 24V, 0.1 A), 2-wire 

RS-485/422 (half-duplex), alternative voltage input
• D-Sub connector: RS-232
• Power: 9V DC

Processors and memory • CPU: ETRAX-100 LX 32-bit
• Video processing and compression: ARTPEC-2 chip
• RAM AXIS 241Q - 64MB RAM
• RAM AXIS 241S - 32MB RAM
• Flash memory - 8 MB
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Power • External power adapter PS-K (included): 9V DC, 9W 
• Via terminal connector: 7-20V DC, max 8W

Operating conditions • Temperature: 5oC (41oF) to 50oC (122oF)
• Humidity: 20-80% RH (non-condensing)

System integration 
support

• API for software integration available at www.axis.com includes HTTP API, AXIS 
Media Control SDK

• Event trigger data in video stream
• Embedded scripting
• Access to serial port peripherals via HTTP/TCP
• Embedded operating system: Linux 2.4

Minimum web browsing 
requirements

• Pentium III 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card, DirectDraw, 32 MB video RAM
• Windows: XP, 2000, NT 4.0, ME or 98
• DirectX 9.0 or later
• Internet Explorer 5.x or later 

For other operating systems and browsers, see www.axis.com/techsup

Supported protocols HTTP, HTTPS, SSL/TLS*, TCP SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, IGMP, RTCP, 
SMTP, FTP, DHCP, UPnP, ARP, DNS, DynDNS, SOCKS

*This product includes software developed by the Open SSL Project for use in the 
Open SSL Tool kit. See www.openssl.org

Approvals - EMC • EN55022:1998+A1 (CISPR 22:1997+A1) Class B
• EN55024:1998+A1+A2 
• EN61000-3-2:2000 
• EN61000-3-3:1995+A1
• VCCI:2003, Class B, ITE (CISPR 22:1997+A1:2000, Class B) 
• C-Tick AS/NZS 3548
• FCC part 15, Subpart B, Class B, demonstrated by compliance with EN55022:1998 

(CISPR 22:1997) Class B
• ICES-003 Class B, demonstrated by compliance with EN 55022:1998, Class B

Approvals - Safety • EN60950
• UL, CSA (PS-K power adapter)

Dimensions • HxWxD = 42 x 140 x 155mm (1 11/16 x 5 1/2 x 6 1/8”) 
• Weight: 540g (1.2 lb) excluding power adapter

Complimentary Software • AXIS Media Control (AMC) - ActiveX component software required for Microsoft 
Internet Explorer, installed automatically on first use.

• Optional: AXIS IP Utility - Windows installation 

MPEG-4 licensing License for one MPEG-4 encoder and one MPEG-4 decoder included. Additional 
licenses available from Axis dealers. 

Item Specification
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General performance considerations
When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Enabled motion detection. Frame rate and bandwidth affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
241S/241Q provides a tool that can be used to display these values directly in the video 
image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps) 
bandwidth in Kbps) to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 

Important!
•The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

•For Motion JPEG, these values will only be accurate as long as no frame rate limit has been 
specified.
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Frame rates - Motion JPEG 
The following test results show the frame rates in frames/second (fps) for Motion JPEG 
streams from the AXIS 241S/241Q, using a compression level of 50%. Note that these 
values are guidelines only - actual values may vary.

Frame rates - MPEG-4
The following test results show the frame rates in frames/second (fps) for MPEG-4 streams 
from the AXIS 241S/241Q. Note that these values are guidelines only - actual values may 
vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.

fps (PAL/NTSC) 
1 channel

fps (PAL/NTSC)
4 channels

4CIF 25/30 8/10
2CIF expanded 25/30 13/15

2CIF 25/30 22/27
CIF 25/30 25/30

QCIF 25/30 25/30

fps (PAL/NTSC) 
1 channel

fps (PAL/NTSC)
4 channels

4CIF 17/21 3/4
2CIF expanded 17/21 4/5

2CIF 25/30 9/10
CIF 25/30 17/20

QCIF 25/30 25/30
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Bandwidth
As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure
• the analog cameras connected to the video server

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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Installation

Montage

Im Lieferumfang des AXIS 241Q/241S ist ein Montagesatz für die Wandanbringung oder 
den Rackeinbau enthalten. Die Halterungen können so montiert werden, dass der 
Videoserver auf einer senkrechten Fläche angebracht oder in ein Rack (4 HE) eingebaut 
werden kann. Gehen Sie folgendermaßen vor, um die Halterungen an den Videoserver 
anzubringen:

❷

❸

Bringen Sie die Halterungen auf beiden 
Seiten in die richtige Lage, und schrauben 
Sie diese mit den dafür vorgesehenen 
Schrauben fest.

Schieben Sie die Metallplatten in die Schlitze 
auf beiden Seiten des Videoservers.

❶

❶

Ziehen Sie den grauen Rahmen vorn am 
Videoserver ab (kein Werkzeug erforderlich).

❸

❸

Alternative A

Alternative B
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Videokameras anschließen

Schließen Sie den Video-Ausgang Ihrer 
Kamera(s) mit einem 
Standard-Koaxial-Videokabel (75 Ohm) 
mit BNC-Anschlüssen an den AXIS 
241Q/241S Videoserver an.

       Koaxial-Kabel

Hinweis: Verwenden Sie einen RCA/BNC-Adapter, 
falls Ihre Kamera über einen RCA-Anschluss verfügt.

Installationsmethoden
Der AXIS 241Q/241S ist für die Installation in einem Ethernet-Netzwerk vorgesehen. Dazu 
muss dem Videoserver entweder manuell oder über einen automatischen Netzwerkservice 
(DHCP) eine IP-Adresse zugewiesen werden. Wählen Sie entsprechend Ihrem Netzwerk eine 
der folgenden Methoden: 

• Verwenden Sie unter Windows das Programm AXIS IP Utility, um eine dynamisch 
zugewiesene IP-Adresse zu ermitteln oder eine IP-Adresse manuell zuzuweisen.

• Bei Verwendung eines DHCP-Servers können Sie auf den Administrationsseiten dieses 
Servers herausfinden, welche IP-Adresse dem AXIS 241Q/241S zugewiesen wurde. 

• Falls Sie einen DHCP-Server verwenden und auf Ihrem Computer der UPnP™-Dienst 
ausgeführt wird, wird AXIS 241Q/241S automatisch erkannt und auf dem Bildschirm 
angezeigt. Siehe Seite 65.

• Weisen Sie die IP-Adresse manuell mit der ARP/Ping-Methode zu. Die Anleitung hierzu 
finden Sie auf  Seite 65.

• Wenn Ihr Netzwerk über einen Internetanschluss (ohne Proxyserver für HTTP-Zugang) 
verfügt und Sie zur Zuweisung von IP-Adressen einen DHCP-Server verwenden, sollten Sie 
nach dem One-Click-Verfahren vorgehen. Siehe Seite 68.

Hinweise: • Die Standard-IP-Adresse des AXIS 241Q/241S lautet: 192.168.0.90
• DHCP ist im AXIS 241Q/241S standardmäßig aktiviert.
• UPnP™ ist im AXIS 241Q/241S standardmäßig aktiviert.
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AXIS IP Utility

AXIS IP Utility ist eine kostenlose 
Windows-Anwendung, mit der 
Axis-Geräte im Netzwerk erkannt 
und angezeigt werden. Die 
Anwendung dient außerdem zum 
manuellen Festlegen einer statischen 
IP-Adresse. Sie können AXIS IP 
Utility von den Supportseiten unter 
www.axis.com/techsup/software herunterladen.

Automatische Erkennung

1. Prüfen Sie, ob Netzwerk- und Stromkabel mit dem AXIS 241Q/241S verbunden sind.

2. Starten Sie AXIS IP Utility. Klicken Sie auf das Symbol des AXIS 241Q/241S, um die 
entsprechende Homepage zu öffnen. 

IP-Adresse manuell einstellen

Wenn das Symbol des AXIS 241Q/241S nicht im Fenster angezeigt wird, klicken Sie auf 
die Schaltfläche Aktualisieren, um erneut nach dem Gerät zu suchen. Wird das Gerät 
immer noch nicht angezeigt, müssen Sie die IP-Adresse manuell zuweisen. 

1. Wählen Sie eine nicht zugewiesene IP-Adresse. AXIS IP Utility erkennt das Subnetz, 
an das Ihr Computer angeschlossen ist. Der AXIS 241Q/241S muss im selben 
Netzwerksegment installiert werden.

2. Klicken Sie auf die Schaltfläche  (IP-Adresse mit Seriennummer festlegen), und 
geben Sie die Seriennummer und die IP-Adresse für die AXIS 241Q/241S ein. 

3. Klicken Sie auf die IP-Adresse festlegen und starten Sie die AXIS 241Q/241S 
innerhalb von zwei Minuten neu.

4. Klicken Sie auf Homepage anzeigen, um auf die Webseiten der AXIS 241Q/241S zu 
gelangen. 

5. Geben Sie ein Passwort für den Root-Benutzer (Administrator) ein.

6. Bestätigen Sie die Installation von AMC auf Ihrem Computer.

Hinweis: • Mit AXIS IP Utility lässt sich auch die IP-Adresse ändern, die zuvor einem Axis-Gerät zugewiesen wurde.
• AMC (AXIS Media Control) muss installiert sein, damit Video-Direktübertragungen im Microsoft 

Internet Explorer angezeigt werden können. Falls in Ihrer Arbeitsumgebung die Installation weiterer 
Softwarekomponenten nicht zugelassen ist, können Sie Ihren AXIS 241Q/241S so konfigurieren, dass 
zum Aktualisieren der Bilder ein Java-Applet verwendet wird. Siehe Hilfedatei unter Live View Config 
(Direktübertragung konfigurieren) > Layout (Ansicht) > Default Viewer for Internet Explorer 
(Standard-Viewer für Internet Explorer), oder verwenden Sie einen anderen unterstützten Webbrowser 
(siehe Technical Specifications, auf Seite 57). 
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7. Die Installation ist damit abgeschlossen. Fahren Sie mit dem Abschnitt Using the video 
server, auf Seite 16 fort.

UPnP™ 

Die UPnP-Funktionalität des AXIS 241Q/241S ist standardmäßig aktiviert. Sofern diese 
Funktionalität auch auf Ihrem Computer (Windows ME oder XP) aktiviert ist, wird der 
Videoserver automatisch erfasst, und unter "Netzwerkumgebung" wird ein entsprechendes 
Symbol hinzugefügt. Klicken Sie auf dieses Symbol, um auf den AXIS 241Q/241S 
zuzugreifen.

Hinweis:   

Zur Installation des UPnP-Dienstes auf Ihrem Computer öffnen Sie im Startmenü die Systemsteuerung. 
Wählen Sie hier "Software". Wählen Sie "Windows-Komponenten hinzufügen/entfernen", und 
wechseln Sie zum Bereich "Netzwerkdienste". Klicken Sie auf "Details", und wählen Sie dann UPnP als 
hinzuzufügenden Dienst aus.

UPnP™ ist eine Zertifizierungsmarke der UPnP™ Implementers Corporation.

ARP und Ping unter Windows

Gehen Sie folgendermaßen vor, um Ihrem Produkt von einem Computer Ihres Netzwerks 
aus eine eindeutige IP-Adresse zuzuweisen:

1. Lassen Sie sich von Ihrem Netzwerkadministrator eine nicht zugewiesene IP-Adresse 
für den AXIS 241Q/241S geben.

2. Schließen Sie den AXIS 241Q/241S über ein Standard-Netzwerkkabel an das Netzwerk 
an.

3. Die Seriennummer/MAC-Adresse (S/N) ist auf dem Etikett auf der Unterseite des AXIS 
241Q/241S zu finden.

4. Öffnen Sie auf einem Computer Ihres Netzwerks das Befehlszeilenprogramm. Wählen 
Sie dazu beispielsweise im Windows-Startmenü die Option Ausführen..., und geben 
Sie cmd ein (command für Windows 98/ME). Klicken Sie auf OK.

5. Geben Sie folgende Befehle ein:
           Syntax:

Die Seriennummer (S/N) befindet sich auf dem Etikett auf der Unterseite des AXIS 241Q/241S.

arp -s <IP-Adresse> <Seriennummer> 
ping -l 408 -t <IP-Adresse>

Hinweis: Auf den Ping-Befehl 
folgt -l (kleines L).
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   Beispiel

6. Starten Sie den AXIS 241Q/241S, bzw. starten Sie ihn neu. Der Start/Neustart muss 
binnen zwei Minuten nach Eingabe der Befehle "ARP" und "Ping" erfolgen.

7. Sobald "Antwort von 192.168.0.125: ..." angezeigt wird, also nach ca. 10–15 
Sekunden, können Sie den Ping-Befehl durch Betätigen von Ctrl+C stoppen.

8. Starten Sie einen Webbrowser, und geben Sie im Adressfeld die IP-Adresse ein.
9. Betätigen Sie die Eingabetaste.
10. Geben Sie ein Passwort für den Root-Benutzer (Administrator) ein.
11. Bestätigen Sie die Installation von AMC auf Ihrem Computer.

Hinweis: AMC muss installiert sein, damit Video-Direktübertragungen im Microsoft Internet Explorer angezeigt 
werden können. Falls in Ihrer Arbeitsumgebung die Installation weiterer Softwarekomponenten nicht 
zugelassen ist, können Sie Ihren AXIS 241Q/241S so konfigurieren, dass zum Aktualisieren der Bilder ein 
Java-Applet verwendet wird. Einzelheiten dazu finden Sie in der Hilfedatei unter Live View Config 
(Direktübertragung konfigurieren) > Layout (Ansicht) > Default Viewer for Internet Explorer 
(Standard-Viewer für Internet Explorer). Oder verwenden Sie einen anderen unterstützten Webbrowser 
(siehe Technical Specifications, auf Seite 57).

12. Die Installation ist damit abgeschlossen. Fahren Sie mit dem Abschnitt Using the video 
server, auf Seite 16 fort.
Download from Www.Somanuals.com. All Manuals Search And Download.



 67 AXIS 241Q/241S - Installation
ARP and Ping unter UNIX/Linux
Gehen Sie folgendermaßen vor, um Ihrem Produkt von einem Computer Ihres Netzwerks 
aus eine eindeutige IP-Adresse zuzuweisen:

1. Lassen Sie sich von Ihrem Netzwerkadministrator eine nicht zugewiesene IP-Adresse 
für den AXIS 241Q/241S geben.

2. Schließen Sie den AXIS 241Q/241S über ein Standard-Netzwerkkabel an das Netzwerk 
an.

3. Die Seriennummer (S/N) ist auf dem Etikett auf der Unterseite des AXIS 241Q/241S zu 
finden.

4. Starten Sie den AXIS 241Q/241S, bzw. starten Sie ihn neu. Der Start/Neustart muss 
binnen zwei Minuten nach Eingabe der Befehle "ARP" und "Ping" erfolgen.

5. Beenden Sie die ARP/Ping-Sitzung, sobald "Antwort von 192.168.0.125: ..." oder etwas 
Ähnliches angezeigt wird (nach ca. 10–15 Sekunden).

6. Starten Sie einen Webbrowser, und geben Sie im Adressfeld die IP-Adresse ein.

7. Betätigen Sie die Eingabetaste.

8. Geben Sie ein Passwort für den Root-Benutzer (Administrator) ein.

9. Die Installation ist damit abgeschlossen. Fahren Sie mit dem Abschnitt Using the video 
server, auf Seite 16 fort.

Syntax:

arp -s <IP-Adresse > <Seriennummer> temp 
ping -s 408 <IP-Adresse>

Beispiel:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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AXIS Internet Dynamic DNS Service
Der AXIS Internet Dynamic DNS Service wird von Axis als kostenloser Service zur 
Verfügung gestellt. Damit können Sie Ihren Videoserver schnell und einfach installieren. 
Der Videoserver erhält dabei einen statischen Namen (DNS-Namen) und eine dynamische 
IP-Adresse. Weitere Einzelheiten zum AXIS Internet Dynamic DNS Service erhalten Sie 
unter www.axiscam.net.

Die Registrierung des Videoservers bei diesem Service kann jederzeit gelöscht werden.

Unter www.axiscam.net finden Sie weitere Informationen zum AXIS Internet Dynamic 
DNS Service.

Anforderungen
Voraussetzung für die Verwendung des AXIS Internet Dynamic DNS Service ist eine 
Internetverbindung, bei der für den HTTP-Zugriff kein Proxyserver verwendet wird. Für 
das Zuweisen von IP-Adressen wird die Verwendung eines DHCP-Servers empfohlen.

Installationsvorgang

1. Schließen Sie den AXIS 241Q/241S über ein Standard-Netzwerkkabel an das Netzwerk 
an.

2. Schließen Sie den Videoserver ans Stromnetz an.

3. Warten Sie, bis die Statusanzeige an der Vorderseite des Videoservers konstant grün 
leuchtet. Dadurch wird angezeigt, dass der Server eine dynamische IP-Adresse von 
einem DHCP-Server im Netzwerk erhalten hat.

4. Warten Sie 60 Sekunden, und betätigen Sie danach die Steuertaste an der Vorderseite 
des Servers einmal. Die Statusanzeige vorn am Server blinkt während der Verbindung 
mit dem AXIS Internet Dynamic DNS Service grün. Nach Abschluss der Registrierung 
geht die Anzeige wieder auf Dauergrün über.

5. Auf der Website www.axiscam.net werden Sie durch den restlichen 
Installationsprozess geführt. Halten Sie die Seriennummer Ihres Produktes bereit, und 
befolgen Sie die Anweisungen auf dem Bildschirm.

6. Geben Sie ein Passwort für den Root-Benutzer (Administrator) ein.

7. Bestätigen Sie die Installation von AMC auf Ihrem Computer.

Hinweis: Bei diesem Verfahren werden die IP-Adresse, Firmware-Version, Seriennummer sowie der 
Produkttyp des AXIS 241Q/241S an den Axis Internet Dynamic DNS Service übermittelt.  
Es werden keine persönlichen Daten übertragen.

Die Seriennummer (S/N) befindet sich auf dem Etikett auf der Unterseite des AXIS 241Q/241S.
Download from Www.Somanuals.com. All Manuals Search And Download.



 69 AXIS 241Q/241S - Installation
Hinweis: MC muss installiert sein, damit direkt übertragene Bilder im Microsoft Internet Explorer angezeigt 
werden können. Falls in Ihrer Arbeitsumgebung die Installation weiterer Softwarekomponenten nicht 
zugelassen ist, können Sie Ihren AXIS 241Q/241S so konfigurieren, dass zum Aktualisieren der Bilder ein 
Java-Applet verwendet wird. Einzelheiten dazu finden Sie in der Hilfedatei unter Live View Config 
(Direktübertragung konfigurieren) > Layout (Ansicht) > Default Viewer for Internet Explorer 
(Standard-Viewer für Internet Explorer). Siehe auch Abschnitt Technical Specifications, auf Seite 57.

8. Die Installation ist damit abgeschlossen. Fahren Sie mit dem Abschnitt Using the video 
server, auf Seite 16 fort.
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Installation

Montage

Votre AXIS 241Q/241S est équipé d’un kit de montage pour support mural ou sur baie 
(rack). Les supports de montage peuvent être positionnés pour monter le serveur vidéo sur 
une surface verticale ou dans une baie (4U). Suivez les instructions ci-dessous pour fixer 
les supports de montage au serveur vidéo :

❷

❸

Positionnez et fixez les supports de chaque côté 
à l’aide des vis prévues à cet effet.

Insérez les plaques métalliques dans les 
logements de chaque côté du serveur vidéo.

❶

❶

Faites glisser la structure du panneau avant du 
serveur pour l’enlever (pas besoin d’outils).

❸

❸

Solution A

Solution B
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Connexion des caméras vidéo        Câble coaxial

Connectez la sortie vidéo de votre ou 
vos caméras à votre AXIS 241Q/241S à 
l’aide d’un câble vidéo coaxial standard 
de 75 Ohms avec connecteurs BNC.

Remarque : Utilisez un adaptateur RCA/BNC si votre caméra dispose d’un connecteur de type phono (RCA).

Méthodes d’installation
Votre AXIS 241Q/241S est conçu pour une installation dans un réseau Ethernet. Cela 
implique de lui affecter une adresse IP, soit manuellement soit via un service réseau 
automatisé (DHCP). Sélectionnez l’une des procédures suivantes en fonction de votre 
réseau : 

• Sous Windows, utilisez l’application AXIS IP Utility pour obtenir une adresse IP dynamique 
ou définir manuellement cette adresse.

• Si votre réseau utilise un serveur DHCP, consultez-en les pages d’administration pour 
déterminer l’adresse IP affectée à votre AXIS 241Q/241S. 

• Si votre réseau utilise un serveur DHCP et si votre ordinateur exécute le service UPnP™, 
votre AXIS 241Q/241S est détecté automatiquement et s’affiche sur votre écran. 
Reportez-vous à la page 73.

• Pour l’attribution manuelle de l’adresse IP selon la méthode ARP/Ping, reportez-vous à la 
page 73.

• Si votre réseau comporte une connexion à Internet (sans proxy HTTP) et utilise un serveur 
DHCP pour attribuer les adresses IP, utilisez la méthode AXIS Internet Dynamic DNS 
Service. Reportez-vous à la page 76.

Remarques : • L’adresse IP du AXIS 241Q/241S par défaut est 192.168.0.90
• DHCP est activé par défaut dans votre AXIS 241Q/241S.
• UPnP™ est activé par défaut dans votre AXIS 241Q/241S.

Application AXIS IP Utility

L’utilitaire AXIS IP Utility est une 
application Windows gratuite servant 
à détecter et afficher les périphériques 
Axis de votre réseau. Cette 
application peut également être 
utilisée pour définir manuellement 
une adresse IP statique. Vous pouvez 
télécharger AXIS IP Utility depuis les 
pages de support sur : 
www.axis.com/techsup/software
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Détection automatique

1. Vérifiez que les câbles d'alimentation et le réseau sont bien raccordés à votre AXIS 
241Q/241S.

2. Démarrez AXIS IP Utility. Double-cliquez sur l’icône AXIS 241Q/241S lorsqu’elle 
apparaît dans la fenêtre de façon à en ouvrir la page d’accueil. 

Définissez manuellement l’adresse IP.

Si AXIS 241Q/241S ne s’affiche pas, cliquez sur le bouton Actualiser pour réessayer. Si 
l’icône ne s’affiche toujours pas, définissez l’adresse IP manuellement. 

1. Trouvez une adresse IP inutilisée. AXIS IP Utility détecte le sous-réseau auquel votre 
ordinateur est connecté. Votre AXIS 241Q/241S doit être installé sur le même segment 
de réseau.

2. Cliquez sur le bouton  (Paramétrer l’adresse IP en utilisant le numéro de série) 
puis saisissez le numéro de série et l’adresse IP de votre AXIS 241Q/241S. 

3. Cliquez sur le bouton Paramétrer IP puis redémarrez votre AXIS 241Q/241S (dans les 
2 minutes).

4. Cliquez sur Afficher page d’accueil pour accéder aux pages Web de votre AXIS 
241Q/241S.

5. Entrez un mot de passe pour l’utilisateur root (administrateur).

6. Le cas échéant, acceptez l’installation de AMC sur votre station de travail.

Remarques : • AXIS IP Utility permet également de modifier l’adresse IP d’un appareil Axis détecté précédemment.
• AMC (AXIS Media Control) doit être installé pour visionner les données vidéo en direct dans 

Microsoft Internet Explorer. Si votre environnement de travail limite les composants logiciels 
supplémentaires, vous pouvez configurer votre AXIS 241Q/241S pour utiliser un applet Java pour 
mettre à jour les images. Consultez le fichier d’aide Live View Config > Layout > Default Viewer for 
Internet Explorer ou utilisez un autre navigateur Web pris en charge (voir Technical Specifications, à 
la page 57). 

7. L’installation est terminée. Passez à Using the video server, à la page 16. 

Le numéro de série (S/N) figure sur l’étiquette sous le serveur vidéo AXIS 241Q/241S
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UPnP™ 

La fonction UPnPest activée par défaut dans votre AXIS 241Q/241S. Si elle est aussi 
activée sur votre ordinateur (Windows ME ou XP), le serveur vidéo sera automatiquement 
détecté et une nouvelle icône sera ajoutée à « Mes emplacements réseau ». Cliquez sur cette 
icône pour accéder à votre AXIS 241Q/241S. 

Remarque : 

Pour installer le service UPnP sur votre ordinateur, ouvrez le Panneau de configuration depuis le menu 
Démarrer et sélectionnez Ajout/suppression de programmes. Sélectionnez Ajouter/Supprimer des 
composants Windows et ouvrez la section Services de mise en réseau. Cliquez sur Détails, puis 
sélectionnez UPnP comme service à ajouter.

UPnPTM est une marque de certification de UPnPTM Implementers Corporation.

ARP et Ping sous Windows

Affectez une adresse IP unique à votre ordinateur à partir d’un ordinateur du réseau, en 
procédant comme suit :

1. Trouvez une adresse IP non utilisée pour votre AXIS 241Q/241S en la demandant à 
votre administrateur de réseau.

2. Connectez votre AXIS 241Q/241S à votre réseau à l’aide d’un câble de réseau standard.

3. Repérez le numéro de série (S/N) sur l’étiquette collée sur la partie inférieure de votre 
AXIS 241Q/241S

4. A partir d’un ordinateur de votre réseau, ouvrez une invite de commande, par exemple 
à partir du menu Démarrer de Windows, sélectionnez Exécuter... et tapez cmd 
(command sous Windows 98/ME). Cliquez sur OK.

5. Entrez les commandes :
           Syntaxe :

   Exemple

arp -s <Adresse IP> <Numéro de série> 
ping -l 408 -t <Adresse IP>

Remarque : La commande Ping est 
suivie de -l (L minuscule)
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6. Démarrez/redémarrez votre AXIS 241Q/241S. Vous devez le faire dans les 2 minutes 
qui suivent la saisie des commandes ARP et Ping.

7. Lorsque le message « Reply from 192.168.0.125: ... » (Réponse de) s’affiche (au bout 
d’environ 10-15 secondes), tapez Ctrl+C pour fermer la session Ping.

8. Lancez un navigateur Web et entrez l’adresse IP dans le champ Adresse/emplacement.

9. Appuyez sur Entrée.

10. Entrez un mot de passe pour l’utilisateur root (administrateur).

11. Le cas échéant, acceptez l’installation de AMC sur votre station de travail.

Remarque : AMC doit être installé pour visionner les images vidéo en direct dans Microsoft Internet Explorer. 
Si votre environnement de travail limite les composants logiciels supplémentaires, vous pouvez 
configurer votre AXIS 241Q/241S pour utiliser un applet Java pour mettre à jour les images. 
Reportez-vous au fichier d’aide sous Live View Config > Layout > Default Viewer for Internet 
Explorer pour de plus amples informations. Vous pouvez également utiliser un autre navigateur 
Web pris en charge ; reportez-vous aux Technical Specifications, à la page 57.

12. L’installation est terminée. Passez à Using the video server, à la page 16.
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ARP et Ping sous UNIX/Linux
Affectez une adresse IP unique à votre ordinateur à partir d’un ordinateur du réseau, en 
procédant comme suit :

1. Trouvez une adresse IP non utilisée pour votre AXIS 241Q/241S en la demandant à 
votre administrateur de réseau.

2. Connectez votre AXIS 241Q/241S à votre réseau à l’aide d’un câble de réseau standard.

3. Repérez le numéro de série (S/N) sur l’étiquette collée sur la partie inférieure de votre 
AXIS 241Q/241S

4. Démarrez/redémarrez votre AXIS 241Q/241S. Vous devez le faire dans les 2 minutes 
qui suivent la saisie des commandes ARP et Ping.

5. Fermez la session ARP Ping dès que le message « Reply from 192.168.0.125: ... » 
(Réponse de) ou similaire s’affiche (au bout d’environ 10-15-secondes).

6. Lancez un navigateur Web et entrez l’adresse IP dans le champ Adresse/emplacement.

7. Appuyez sur Entrée.

8. Entrez un mot de passe pour l’utilisateur root (administrateur).

9. L’installation est terminée. Passez à Using the video server, à la page 16.

Syntaxe:

arp -s <Adresse IP> <Numéro de série> temp 
ping -s 408 <Adresse IP>

Exemple:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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AXIS Internet Dynamic DNS Service
AXIS Internet Dynamic DNS Service est un service gratuit offert par Axis pour vous 
permettre d’installer rapidement et facilement votre serveur vidéo, qui reçoit ainsi un nom 
statique (nom DNS) et une adresse IP dynamique. Davantage d’informations sur l’AXIS 
Internet Dynamic DNS Service sont disponibles sur le site www.axiscam.net.

Le serveur vidéo peut être désactivé à tout moment.

Visitez www.axiscam.net pour de plus amples détails sur AXIS Internet Dynamic DNS 
Service.

Configuration minimale requise
AXIS Internet Dynamic DNS Service nécessite une connexion Internet qui n’exige pas de 
serveur proxy pour l’accès http. Nous recommandons un serveur DHCP dans le réseau pour 
l’affectation des adresses IP.

Procédure d’installation

1. Connectez votre AXIS 241Q/241S à votre réseau local à l’aide d’un câble réseau 
standard.

2. Connectez le cordon d’alimentation au serveur vidéo.

3. Attendez que le voyant d’état sur la partie avant du serveur vidéo passe au vert, ce qui 
signale la réception d’une adresse IP dynamique d’un serveur DHCP sur votre réseau.

4. Attendez 60 secondes et appuyez une fois sur le bouton de commande du panneau 
avant. Le voyant d’état sur la partie avant du serveur vidéo clignote (vert) pendant la 
connexion à AXIS Internet Dynamic DNS Service. Une fois le processus 
d’enregistrement terminé, le voyant arrête de clignoter (vert fixe).

5. Visitez le site www.axiscam.net où vous serez guidé pour l'exécution des dernières 
phases de l’installation. Veuillez avoir le numéro de série de votre produit à portée de 
main et suivre les instructions qui s’affichent à l’écran.

6. Entrez un mot de passe pour l’utilisateur root (administrateur).

Remarquez que cette procédure enverra l’adresse IP de votre AXIS 241Q/241S, la version du logiciel 
microprogrammé et le numéro de série à Axis Internet Dynamic DNS Service.  
Aucune information personnelle ne sera transmise.

Le numéro de série (S/N) figure sur l’étiquette sous votre AXIS 241Q/241S
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7. Le cas échéant, acceptez l’installation de AMC sur votre station de travail.

Remarque : AMC doit être installé pour visionner les images en direct dans Microsoft Internet Explorer. Si votre 
environnement de travail limite les composants logiciels supplémentaires, vous pouvez configurer 
votre AXIS 241Q/241S pour utiliser un applet Java pour mettre à jour les images. Reportez-vous au 
fichier d’aide sous Live View Config > Layout > Default Viewer for Internet Explorer pour de plus 
amples informations. Consultez également les Technical Specifications, à la page 57.

8. L’installation est terminée. Passez à Using the video server, à la page 16.
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Installazione

Montaggio
AXIS 241Q/241S comprende un kit per montaggio a parete o su rack. Le staffe di 
montaggio possono essere posizionate per montare il server video su una superficie 
verticale o in un armadio rack (4U). Seguire le istruzioni in basso per collegare le staffe al 
server video:

❷

❸

Posizionare e collegare le staffe su 
ciascun lato utilizzando le viti fornite.

Inserire le piastre di metallo negli slot su 
entrambi i lati del server video.

❶

❶

Estrarre il telaio grigio dal pannello anteriore del 
server video (non sono necessari attrezzi).

❸

❸

Alternativa A

❸
Alternativa B
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Connessione delle videocamere
Collegare l’uscita video delle 
videocamere al server video AXIS 
241Q/241S utilizzando un cavo 
coassiale standard 75 Ohm con 
connettori BNC.

       Cavo coassiale

Nota: Utilizzare un convertitore RCA-BNC se la 
videocamera è dotata di un connettore 
standard RCA.

Metodi di installazione
L'AXIS 241Q/241S è progettata per l'installazione in una rete Ethernet. Ciò implica 
l’assegnazione automatica, ad esempio tramite un servizio di rete quale DHCP o manuale di 
un indirizzo IP. Selezionare una delle seguenti procedure in base alla rete: 

• In Windows, utilizzare AXIS IP Utility individuare un indirizzo IP dinamico o per impostare 
manualmente l’indirizzo IP.

• Se la rete utilizza un server DHCP, visualizzarne le pagine di amministrazione per 
individuare l’indirizzo IP assegnato all’AXIS 241Q/241S. 

• Se la rete utilizza un server DHCP e il computer esegue UPnP™, l’AXIS 241Q/241S sarà 
rilevata automaticamente e visualizzata sullo schermo. Vedere  pagina 81.

• Assegnare manualmente l’indirizzo IP mediante il metodo ARP/Ping, descritto a pagina 81.
• Se la rete dispone di una connessione Internet (senza proxy HTTP) e utilizza un server 

DHCP per assegnare gli indirizzi IP, utilizzare la procedura di installazione in un solo clic. 
Vedere  pagina 84.

Note: • L’indirizzo IP predefinito per l’AXIS 241Q/241S è 192.168.0.90
• Nell’AXIS 241Q/241SDHCP è attivo per impostazione predefinita
• Nell’AXIS 241Q/241SUPnP™ è attiva per impostazione predefinita

AXIS IP Utility
AXIS IP Utility è 
un'applicazione gratuita per 
Windows che consente di 
individuare e visualizzare la 
presenza di periferiche Axis 
sulla rete. Permette inoltre di 
impostare manualmente un 
indirizzo IP statico. Scaricare 
l’utility AXIS IP dalle pagine di 
supporto al seguente indirizzo: 
www.axis.com/techsup/software
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Rilevamento automatico

1. Controllare che i cavi di rete e di alimentazione siano collegati all'AXIS 241Q/241S.

2. Avviare AXIS IP Utility. Quando l’AXIS 241Q/241S verrà visualizzata, fare doppio clic 
su di essa per aprirne l'home page. 

Impostazione manuale dell'indirizzo IP
Se l'AXIS 241Q/241S non viene visualizzata all'interno della finestra, fare clic sul pulsante 
Aggiorna per effettuare un nuovo tentativo. Se fallisce anche questo tentativo, è possibile 
impostare manualmente l’indirizzo IP. 

1. Acquisire un indirizzo IP non utilizzato. AXIS IP Utility rileva la subnet a cui è 
connesso il computer. L’AXIS 241Q/241S deve essere installata sullo stesso segmento 
di rete.

2. Fare clic sul pulsante  (Imposta indirizzo IP mediante numero di serie) e immettere 
il numero di serie e l'indirizzo IP dell'AXIS 241Q/241S. 

3. Fare clic sul pulsante Imposta IP e riavviare l’AXIS 241Q/241S (entro 2 minuti).

4. Fare clic su Visualizza la Home Page per accedere alle pagine Web dell’AXIS 
241Q/241S. 

5. Immettere una password per l’utente root (amministratore).
6. Se necessario, accettare l’installazione di AMC sulla workstation.

Note: • AXIS IP Utility può anche essere utilizzato per modificare l’indirizzo IP di un dispositivo Axis rilevato in 
precedenza.

• AMC (AXIS Media Control) deve essere installato per visualizzare le immagini dal vivo con Internet Explorer 
di Microsoft. Se l’ambiente di lavoro non consente l’aggiunta di componenti software, è possibile 
configurare AXIS 241Q/241S in modo da utilizzare un’applet Java per l’aggiornamento delle immagini. 
Vedere il file della Guida Live View Config (Config immagini dal vivo) > Layout (Layout) > Default Viewer for 
Internet Explorer (Visualizzazione predefinita per Internet Explorer) oppure utilizzare un altro browser Web 
supportato, vedere Technical Specifications, alla pagina 57. 

7. L’installazione è stata completata. Andare alla sezione Using the video server, alla 
pagina 16. 

Il numero di serie (S/N) è riportato sull'etichetta sulla parte inferiore dell'AXIS 241Q/241S.
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UPnP™ 
La funzionalitàUPnP è attiva per impostazione predefinita nell’AXIS 241Q/241S. Se è 
abilitata anche sul computer in uso (con sistema operativo Windows ME o XP), il server 
video verrà automaticamente rilevato e verrà aggiunta una nuova icona in "Risorse di 
rete". Fare clic su questa icona per accedere all'AXIS 241Q/241S. 

Nota: 

Per installare il servizio UPnP sul computer, aprire il Pannello di controllo dal menu Start e 
selezionare Installazione applicazioni. Selezionare Installazione componenti di Windows e aprire la 
sezione Servizi di rete. Fare clic su Dettagli e selezionare UPnP come servizio da aggiungere.

UPnPTM è un marchio di certificazione dell'UPnPTM Implementers Corporation.

ARP e Ping in Windows
Assegnare al prodotto un indirizzo IP unico da un computer della rete, come segue:

1. Ottenere un indirizzo IP non utilizzato per l'AXIS 241Q/241S dall’amministratore di 
rete.

2. Collegare l’AXIS 241Q/241S alla rete mediante un cavo di rete standard.
3. Individuare il numero di serie (S/N) sull'etichetta sulla parte inferiore dell'AXIS 

241Q/241S.
4. Da un computer della rete, aprire un prompt dei comandi, ad esempio, dal menuStart 

di Windows, selezionare Esegui... e digitare cmd (command in Windows 98/ME). Fare 
clic su OK.

5. Immettere i comandi:
           Sintassi:

   Esempio

6. Avviare/riavviare l’AXIS 241Q/241S. Tale operazione deve essere eseguita entro 2 
minuti dall’immissione dei comandi ARP e Ping.

arp -s <Indirizzo IP> <Numero di serie> 
ping -l 408 -t <Indirizzo IP>

Nota: il comando ping è 
seguito da -l (L minuscola)
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7. Quando viene visualizzato ‘Reply from 192.168.0.125: ...’ (circa 10-15 secondi), 
digitare Ctrl+C per interrompere la sessione Ping.

8. Avviare un browser Web e immettere l’indirizzo IP nel campo Indirizzo/Posizione.
9. Premere Invio.
10. Immettere una password per l’utente root (amministratore).
11. Se necessario, accettare l’installazione di AMC sulla workstation.

Nota: AMC deve essere installato per visualizzare le immagini dal vivo in Internet Explorer di Microsoft. Se 
l’ambiente di lavoro non consente l’aggiunta di componenti software, è possibile configurare AXIS 
241Q/241S in modo da utilizzare un’applet Java per l’aggiornamento delle immagini. Vedere il file della 
Guida in Live View Config (Config immagini dal vivo) > Layout (Layout)> Default Viewer for Internet 
Explorer (Visualizzazione predefinita per Internet Explorer) per informazioni. Oppure utilizzare un altro 
browser Web supportato, vedere Technical Specifications, alla pagina 57.

12. L’installazione è stata completata. Andare alla sezione Using the video server, alla 
pagina 16.
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ARP e Ping in UNIX/Linux
Assegnare al prodotto un indirizzo IP unico da un computer della rete, come segue:

1. Ottenere un indirizzo IP non utilizzato per l'AXIS 241Q/241S dall’amministratore di 
rete.

2. Collegare l’AXIS 241Q/241S alla rete mediante un cavo di rete standard.

3. Individuare il numero di serie (S/N) sull'etichetta sulla parte inferiore dell'AXIS 
241Q/241S.

4. Avviare/riavviare l’AXIS 241Q/241S. Tale operazione deve essere eseguita entro 2 
minuti dall’immissione dei comandi ARP e Ping.

5. Chiudere la sessione ARP/Ping una volta visualizzato ‘Reply from 192.168.0.125: ...’ o 
un messaggio simile (circa 10-15 secondi).

6. Avviare un browser Web e immettere l’indirizzo IP nel campo Indirizzo/Posizione.

7. Premere Invio.

8. Immettere una password per l’utente root (amministratore).

9. L’installazione è stata completata. Andare alla sezione Using the video server, alla 
pagina 16.

Sintassi:

arp -s <Indirizzo IP> <Numero di serie> temp 
ping -s 408 <Indirizzo IP>

Esempio:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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Servizio AXIS Internet Dynamic DNS
Il servizio AXIS Internet Dynamic DNS è un servizio gratuito fornito da Axis, che consente 
di installare in modo rapido e facile il server video, che riceve un nome statico (nome DNS) 
e un indirizzo IP dinamico. Ulteriori informazioni sul servizio AXIS Internet Dynamic DNS 
sono disponibili all'indirizzo www.axiscam.net.

La registrazione per l’assistenza del server video può essere annullata in qualsiasi 
momento.

Per ulteriori dettagli sul servizio AXIS Internet Dynamic DNS, visitare il sito Web 
www.axiscam.net.

Requisiti
L’utilizzo del servizio AXIS Internet Dynamic DNS richiede una connessione Internet che 
non necessiti di un server proxy per l’accesso HTTP. È consigliata la presenza di un server 
DHCP nella rete per l’assegnazione degli indirizzi IP.

Procedura di installazione

1. Collegare l’AXIS 241Q/241S alla rete locale mediante un cavo di rete standard.

2. Collegare l’alimentazione al server video.

3. Attendere che l’indicatore di stato sulla parte anteriore del server video emetta una 
luce verde fissa, segno che ha ricevuto un indirizzo IP dinamico da un server DHCP 
della rete.

4. Attendere 60 secondi, quindi premere una sola volta il pulsante di controllo sul 
pannello anteriore. Durante il collegamento al servizio AXIS Internet Dynamic DNS, 
l'indicatore di stato sulla parte anteriore del server video emette una luce verde 
lampeggiante. Completato il processo di registrazione, la luce verde dell’indicatore 
ritorna fissa.

5. Visitare il sito Web www.axiscam.net per essere guidati attraverso la parte restante 
dell’installazione. Tenere il numero di serie del prodotto a portata di mano ed eseguire 
le istruzioni visualizzate sullo schermo.

6. Immettere una password per l’utente root (amministratore).

7. Se necessario, accettare l’installazione di AMC sulla workstation.

Si noti che con questa procedura si invia l'indirizzo IP, la versione del firmware, il tipo di prodotto e 
il numero di serie dell'AXIS 241Q/241S al servizio Axis Internet Dynamic DNS.  
Non vengono trasferite informazioni personali.

Il numero di serie (S/N) è riportato sull'etichetta sulla parte inferiore dell'AXIS 241Q/241S
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Nota: AMC deve essere installato per visualizzare le immagini dal vivo in Internet Explorer di Microsoft. Se 
l’ambiente di lavoro non consente l’aggiunta di componenti software, è possibile configurare AXIS 
241Q/241S in modo da utilizzare un’applet Java per l’aggiornamento delle immagini. Vedere il file della 
Guida in Live View Config (Config immagini dal vivo) > Layout (Layout)> Default Viewer for Internet 
Explorer (Visualizzazione predefinita per Internet Explorer) per informazioni. Vedere anche Technical 
Specifications, alla pagina 57.

8. L’installazione è stata completata. Andare alla sezione Using the video server, alla 
pagina 16.
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Instalación

Montaje

El AXIS 241Q/241S se suministra con un kit especial para montaje de pared o sobre un 
bastidor (rack). Los soportes de montaje se pueden colocar de manera que servidor de vídeo 
pueda montarse en una superficie vertical o sobre un bastidor (4U). Siga las instrucciones 
siguientes para fijar los soportes de montaje en el servidor de vídeo:

❷

❸

Sitúe y fije los soportes a cada lado con 
los tornillos suministrados.

Introduzca las placas metálicas en las 
ranuras a cada lado del servidor de vídeo.

❶

❶

Retire el armazón gris del panel frontal del servidor 
de vídeo (no necesita herramientas).

❸

Alternativa A

Alternativa B

❸
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Conexión de las cámaras de vídeo
Conecte la salida de vídeo de su(s) 
cámara(s) al servidor de vídeo AXIS 
241Q/241S utilizando un cable de vídeo 
coaxial de 75 ohmios con conectores 
BNC.

       Cable coaxial

Notas: Utilice un adaptador de RCA a BNC si su 
cámara tiene un conector estándar tipo fono (RCA).

Métodos de instalación

El AXIS 241Q/241S está diseñado para instalarse en una red Ethernet. Esto supone asignar 
una dirección IP, ya sea manualmente o a través de un servicio de red automatizado 
(DHCP). Seleccione uno de los procedimientos siguientes según su red: 

• En Windows, utilice la AXIS IP Utility para encontrar una dirección IP dinámica, o para 
definir la dirección IP manualmente.

• Si su red utiliza un servidor DHCP, consulte las páginas de administración del mismo para 
encontrar la dirección IP que se le ha asignado a su AXIS 241Q/241S. 

• Si su red utiliza un servidor DHCP y su PC ejecuta UPnP™, el AXIS 241Q/241S se detectará 
y aparecerá automáticamente en la pantalla. Consulte la página 89.

• Asigne una dirección IP manualmente utilizando el método ARP/Ping, que se describe en la 
página 89.

• Si su red dispone de una conexión a Internet (sin proxy HTTP) y utiliza un servidor DHCP 
para asignar direcciones IP, utilice el Procedimiento de instalación con un solo clic. 
Consulte la página 91.

Notas: • El AXIS 241Q/241S tiene la siguiente dirección IP predeterminada: 192.168.0.90
• El DHCP está habilitado por defecto en el AXIS 241Q/241S
• La funcionalidad UPnP™ está habilitada por defecto en el AXIS 241Q/241S

AXIS IP Utility

AXIS IP Utility es una 
aplicación de Windows 
gratuita que detecta y muestra 
dispositivos Axis en su red, y 
que, además, puede utilizarse 
para asignar manualmente una 
dirección IP estática. Descargue 
AXIS IP Utility de las páginas 
de asistencia técnica en: 
www.axis.com/techsup/software
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Detección automática

1. Compruebe que los cables de red y alimentación estén conectados al AXIS 241Q/241S.
2. Inicie AXIS IP Utility. Cuando aparezca el AXIS 241Q/241S en la ventana, haga doble 

clic en el icono para abrir la página de inicio. 

Configuración manual de la dirección IP

Si el AXIS 241Q/241S no aparece en la ventana, haga clic en el botón Actualizar y vuelva 
a intentarlo. Si sigue sin aparecer, defina la dirección IP manualmente. 

1. Obtenga una dirección IP que no esté en uso. AXIS IP Utility detecta a qué subred está 
conectado su PC. El AXIS 241Q/241S tiene que estar instalado en el mismo segmento 
de red.

2. Haga clic en el botón  (Configurar la dirección IP con el numero de serie) e 
introduzca el número de serie y la dirección IP de la AXIS 241Q/241S. 

3. Haga clic en el botón Configurar IP y, a continuación, reinicie la AXIS 241Q/241S 
(antes de transcurridos 2 minutos desde el clic).

4. Haga clic en Ver Página de inicio para acceder a las páginas web de AXIS 241Q/241S.

5. Introduzca una contraseña para el usuario root (administrador).

6. Si es necesario, acepte la instalación de AMC en su estación de trabajo.

Notas: • También puede utilizarse AXIS IP Utility para cambiar la dirección IP de un dispositivo de Axis que se haya 
detectado con anterioridad.

• AMC (AXIS Media Control) tiene que estar instalado para ver vídeos en vivo en Microsoft Internet Explorer. 
Si su entorno de trabajo posee una limitación de componentes de software adicionales, puede configurar su 
AXIS 241Q/241S para que utilice Java applet para actualizar las imágenes. Consulte el archivo de ayuda 
Live View Config > Layout > Default Viewer para Internet Explorer, o utilice otro navegador de Web 
compatible, consulte Technical Specifications, en la página 57. 

7. La instalación ha finalizado. Vaya a Using the video server, en la página 16. 

El número de serie (S/N) está situado en la etiqueta en el lado inferior del AXIS 241Q/241S
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UPnP™
La funcionalidad UPnP está habilitada de forma predeterminada en el AXIS 241Q/241S. Si 
también está habilitada en su equipo (Windows ME o XP), el servidor de vídeo detectará la 
cámara automáticamente y agregará un nuevo icono a “Mis sitios de red”. Haga clic en este 
icono para acceder al AXIS 241Q/241S. 

Nota: 

ARP y Ping en Windows
Asigne una dirección IP única a su producto desde un ordenador de su red, de la siguiente 
manera:
1. Obtenga una dirección IP que no esté en uso para el AXIS 241Q/241S desde su 

administrador de red.

2. Conecte el AXIS 241Q/241S a la red con un cable de red estándar.

3. Localice el número de serie (S/N) que está situado en la etiqueta en el lado inferior del 
AXIS 241Q/241S.

4. Desde un ordenador de su red, abra un Símbolo del sistema, es decir desde el menú 
Inicio de Windows, seleccione Ejecutar... y teclee cmd (command en Windows 98/ME). 
Haga clic en Aceptar.

5. Introduzca los comandos:

Syntaxis:           

arp -s <Dirección IP> <Número de serie> 
ping -l 408 -t <Dirección IP>

Nota: El comando ping está 
seguido de -l (L minúscula)

Ejemplo:

6. Inicie/reinicie el AXIS 241Q/241S. Para ello, dispone de 2 minutos después de haber 
introducido los comandos ARP y Ping.

Para instalar el servicio UpnP en su equipo, abra el Panel de control desde el menú Inicio y seleccione 
Agregar o quitar programas. Seleccione Agregar o quitar componentes de Windows y abra la sección 
Servicios de red. Haga clic en Detalles y después seleccione UPnP para agregarlo.

UPnPTM es una marca de certificación de UPnPTM Implementers Corporation.
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7. Cuando aparezca ‘Reply from 192.168.0.125: ...’ (aproximadamente 10-15 segundos), 
presione Ctrl+C para detener Ping.

8. Inicie un navegador e introduzca la dirección IP en el campo Dirección/Ubicación.

9. Presione Intro.

10. Introduzca una contraseña para el usuario root (administrador).

11. Si es necesario, acepte la instalación de AMC en su estación de trabajo.

Nota: AMC debe estar instalado para ver vídeos en vivo en Microsoft Internet Explorer. Si su entorno de trabajo 
posee una limitación de componentes de software adicionales, puede configurar su AXIS 241Q/241S para 
que utilice Java applet para actualizar las imágenes. Para más información, consulte el archivo de ayuda 
Live View Config > Layout > Default Viewer para Internet Explorer. O utilice otro navegador de Web 
compatible, consulte Technical Specifications, en la página 57.

12. La instalación ha finalizado. Vaya a Using the video server, en la página 16.

ARP y Ping en UNIX/Linux
Asigne una dirección IP única a su producto desde un ordenador de su red, de la siguiente 
manera:

1. Obtenga una dirección IP que no esté en uso para el AXIS 241Q/241S desde su 
administrador de red.

2. Conecte el AXIS 241Q/241S a la red con un cable de red estándar.

3. Localice el número de serie (S/N) que está situado en la etiqueta en el lado inferior del 
AXIS 241Q/241S.

4. Inicie/reinicie el AXIS 241Q/241S. Para ello, dispone de 2 minutos después de haber 
introducido los comandos ARP y Ping.

5. Cierre la sesión de ARP/Ping cuando aparezca ‘Reply from 192.168.0.125: ...’ (o 
similar) (aproximadamente 10-15 segundos).

6. Inicie un navegador e introduzca la dirección IP en el campo Dirección/Ubicación.

7. Presione Intro.

8. Introduzca una contraseña para el usuario root (administrador).

9. La instalación ha finalizado. Vaya a Using the video server, en la página 16.

Sintaxis:

arp -s <Dirección IP> <Número de serie> temp 
ping -s 408 <Dirección IP>

Ejemplo:

arp -s 192.168.0.125 00:40:8c:18:10:00 temp 
ping -s 408 192.168.0.125
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El AXIS Internet Dynamic DNS Service
El AXIS Internet Dynamic DNS Service es un servicio gratuito de Axis, que le permite 
instalar su servidor de vídeo de forma rápida y sencilla y, después, recibir un nombre 
estático (nombre DNS) y una dirección IP dinámica. Encontrará más información sobre el 
AXIS Internet Dynamic DNS Service en www.axiscam.net

El servidor de vídeo puede darse de baja del servicio en cualquier momento.

Para más información sobre AXIS Internet Dynamic DNS Service, visite www.axicam.net.

Requisitos
Para utilizar AXIS Internet Dynamic DNS Service necesita una conexión a Internet que no 
requiera un servidor proxy para acceso HTTP. Se recomienda el uso de un servidor DHCP 
en la red que se utiliza para asignar direcciones IP.

Procedimiento de instalación

1. Conecte el AXIS 241Q/241S a su red local con un cable de red estándar.

2. Conecte la alimentación al servidor de vídeo.

3. Espere a que el indicador de estado situado en la parte delantera del servidor de vídeo 
se ilumine con una luz verde fija, indicando que ha recibido una dirección IP dinámica 
de un servidor DHCP en su red.

4. Espere 60 segundos y presione una vez el botón de control del panel frontal. El 
indicador de estado del servidor de vídeo parpadea con luz verde mientras se conecta a 
AXIS Internet Dynamic DNS Service. Una vez finalizado el proceso de inscripción, el 
indicador vuelve a brillar con luz verde fija.

5. Visite www.axiscam.net donde le guiarán a través del resto de la instalación. Tenga 
listo el número de serie de su producto y siga las instrucciones de la pantalla.

6. Introduzca una contraseña para el usuario root (administrador).

7. Si es necesario, acepte la instalación de AMC en su estación de trabajo.

Nota: AMC debe estar instalado para poder ver imágenes en vivo en Microsoft Internet Explorer. Si su entorno de 
trabajo posee una limitación de componentes de software adicionales, puede configurar su AXIS 
241Q/241S para que utilice Java applet para actualizar las imágenes. Para más información, consulte el 
archivo de ayuda Live View Config > Layout > Default Viewer para Internet Explorer. Consulte también 
Technical Specifications, en la página 57.

8. La instalación ha finalizado. Vaya a Using the video server, en la página 16.

Tenga en cuenta que, al llevar a cabo este procedimiento, se enviará la dirección IP del AXIS 
241Q/241S, la versión de firmware, el tipo de producto y el número de serie al Axis Internet 
Dynamic DNS Service. No se transferirá ninguna información de carácter personal.

El número de serie (S/N) está situado en la etiqueta en el lado inferior del AXIS 241Q/241S
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Glossary 
ActiveX - A control (or set of rules) used by a browser. 
ActiveX controls are often downloaded and installed 
automatically as required.

API - Application Programming Interface. The Axis API 
can be used for integrating Axis products into other 
applications.

ARP - Address Resolution Protocol. Used to associate an 
IP address to a hardware MAC address. A request is 
broadcast on the local network to find out what the MAC 
address is for the IP address.

ARTPEC - Axis Real Time Picture Encoder - used for 
image compression.

BOOTP - A protocol that can automatically configure a 
network device (give it an IP address). 

CGI - Common Gateway Interface. A set of rules (or a 
program) that allows a Web Server to communicate with 
other programs.

Client/Server - Describes the network relationship 
between two computer programs, in which one, the client, 
makes a service request from another - the server.

DC-Iris - This special type of iris is electrically controlled 
by the Axis camera, to automatically regulate the amount 
of light allowed to enter.

DSL - Digital Subscriber Line. A means of transferring 
data via standard phone lines.

Ethernet - A widely used networking standard.

ETRAX - Axis' own microprocessor.

Firewall - A virtual barrier between a LAN (Local Area 
Network) and other networks, e.g. the Internet.

FTP - File Transfer Protocol. Used for the simple transfer 
of files to and from an FTP-server.

Full-duplex - Transmission of data, e.g. audio, in two 
directions simultaneously. 

Half-duplex- A half-duplex link communicates in one 
direction at a time only, much like a walkie-talkie. Two 
way communication is possible, but not simultaneously. 

HTTP - Hypertext Transfer Protocol. The set of rules for 
exchanging files (text, images, sound, video, and other 
files) on the World Wide Web.

Intranet - A private network limited to an organization or 
corporation. Usually closed to external traffic.

IP - Internet Protocol. See TCP/IP.

IP address - A unique number used by a computer on the 
network to allow it to be identified and found.

ISMA - Internet Streaming Media Alliance.

JPEG - A standard image format, used widely for 

photographs. Also known as JPG.

LAN - A local area network (LAN) is a group of computers 
and associated devices that typically share common 
resources within a limited geographical area.

Linux - A popular operating system that is “open source” 
and practically free of charge.

Lux - A standard unit for light measurement.

Mbit/s - Megabits per second. A unit for measuring 
speeds in networks. A LAN might run at 10 or 100 Mbit/s.

MPEG-4 - A video compression standard that makes good 
use of bandwidth, and which can provide DVD-quality 
video streams at less than 1 Mbit/s. 

Multicast - A bandwidth-conserving technology that 
reduces bandwidth usage by simultaneously delivering a 
single stream of information to multiple network 
recipients. 

PEM - Privacy Enhanced Mail. An early standard for 
securing electronic mail. The PEM-format is often used 
for representing an HTTPS certificate or certificate 
request.

Ping - A small utility used for sending data packets to 
network resources to check that they are working and that 
the network is intact.

Pre/post alarm image - The images from immediately 
before and after an alarm.

Protocol - A special set of rules governing how two 
entities will communicate. Protocols are found at many 
levels of communication, and there are hardware 
protocols and software protocols.

Router - A device that determines the next network point 
to which a packet should be forwarded on its way to its 
final destination. A router is often included as part of a 
network switch (see below).

RTP- Real-Time Transfer Protocol. A transfer protocol 
designed for the delivery of live content, e.g. MPEG-4.

Simplex - In simplex operation, a network cable or 
communications channel can only send information in 
one direction; it's a “one-way street”. 

Subnet Mask - An IP address consists of two 
components: the network address and the host address. 
“Subnetting’ enables a network administrator to further 
divide the host part of the address into two or more 
subnets. The subnet mask identifies the subnet to which 
an IP address belongs. 

Switch - Whilst a simple hub transmits all data to all 
devices connected to it, a switch only transmits the data 
to the device it is specifically intended for. 

SMTP - A common e-mail protocol.
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TCP/IP - Transmission Control Protocol/Internet Protocol. 
A suite of network protocols that determine how data is 
transmitted. TCP/IP is used on many networks, including 
the Internet. TCP keeps track of the individual packets of 
information and IP contains the rules for how the packets 
are actually sent and received. 

UDP - The User Datagram Protocol is a communications 
protocol that offers a limited amount of service when 
messages are exchanged between computers in a network 
that uses the Internet Protocol (IP). UDP is an alternative 
to the Transmission Control Protocol (TCP) and, together 
with IP, is also known as UDP/IP.

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. 

URL - Uniform Resource Locator. An "address" on the 
network.

Varifocal - A varifocal lens provides a wide range of 
focal lengths, as opposed to a lens with a fixed focal 
length, which only provides one.

WAN - Wide-Area-Network. Similar to a LAN, but on a 
larger geographical scale.

Web server - A program on a computer that delivers the 
resources (usually web pages) requested by the web user 
(the client).
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Index

A
Accessing the video stream 21
Action 32
Action buttons 17, 30
Active/Inactive 17, 30
Administrators 23, 40
Advanced TCP/IP settings 43
Alarm 32, 35, 49
Allowed IP addresses 40
AMC 16, 21, 74
Anonymous viewers 40
ARP and Ping 13
AXIS Internet Dynamic DNS Service 15, 42
AXIS IP Utility 11

B
Backup 45
Bandwidth 19, 61
Basic TCP/IP settings 42
Buffers 34

C
CGI links 29, 38
Click-in-image 38
COM Port RS-485 50
Constant bit rate 19
Control button 7, 8, 47
Customize 28

D
Date & Time 41
DC power 49
Default viewer 30
Digital input 49
DIP switch 7, 8
DNS configuration 43

E
Email server 44
Emergency recovery 53

Event servers 32
Event types 32
External video 31
External video sources 17

F
Factory default settings 47
Frame rates 25, 60
FTP server 32

G
Generic HTTP 50
Generic TCP/IP 50

H
Host name 43
HTML examples 31
HTTP API 29, 38
HTTP port number 43
HTTP server 32
HTTPS 41

I
I/O Ports 45
I/O terminal connector 9
Include windows 35
Installation methods 11
Installing PTZ devices 39
Internal video sources 17
IP address filtering 40

L
Live view config 28
Live View page 23
Logs & Reports 46

M
Maximum bandwidth 44
Motion detection 35
Motion JPEG 19
Mounting 10
MPEG-4 19
MPEG-4 clients 22
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MPEG-4 protocols 20
MPEG-4 settings 44
Multicasting 20

N
Network indicator 8
Network settings 42
Network traffic 44
Notification of IP address change 42

O
Operators 40
Output buttons 17, 30
Overlays 25, 27
Own home page 29
Own web files 29

P
Pan/Tilt/Zoom 37, 50
Pinout - I/O connectors 49
Port status 36
Ports & Devices 44
Post-trigger buffer 34
Preset positions 38
Pre-trigger buffer 34
PTZ commands 29, 38
PTZ control queue 38
Pulse 17, 30

Q
Quad stream 17, 26

R
Recovery 53
Referrals 40
Relative and absolute PTZ drivers 37
Restart 45
Restore 45
RS-232 serial connector 9
RS-485 49
RTP 20, 44
RTSP 20, 43

S
Scheduled event 32
Security 40
Sequence mode 17, 31
Serial number 9
Services 42
Set the IP address 12
SMTP settings 44
Snapshot 17
SOCKS server 44
Specifications 57
Streaming MPEG-4 20
Support 46
S-Video 51
System options 40

T
TCP server 32
TCP/IP settings 42
Transistor output 49
Triggered event 32
Troubleshooting 52

U
UDP 20
Unicasting 20
Upgrade Server 45
UPnP 44
User defined links 29
Users 40

V
Variable bit rate 19
Video input 7, 8
Video output 8
Video source 17, 25
Video streams 19, 25
View size 17

Y
Y/C to BNC cable 51
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